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Chapter 1. Getting Started With V5.0 

About these notes 
These update notes are provided for existing users as a supplement to the existing 
Pulsonix Users Guide. These notes are to highlight new features in version 5.0 and to 
briefly describe their use. 

Each chapter is broken down into logical functional descriptions based on the application 
type, Schematic design, PCB design etc. 

Installing the New Version of Pulsonix 
It is recommended that you back-up all libraries, designs, technology files, profile files, 
reports and netlists before installing the latest version. Other than for any reason, this is 
good working practice, although you should have a backup already of all of this data!  

As with any other installation of Pulsonix, insert the CD and wait for a short time. The 
Autorun facility will start the installation procedure. Follow the on-screen messages from 
the install wizard. You can install Pulsonix version 5.0 on top of your existing installation, 
you do not need to uninstall any old version first. 

Licensing 

If you are already using Version 4.6 or an earlier version you will require a new license 
for Version 5.0. This will be supplied to you by email under your current maintenance 
contract. 

For existing users it is recommended that you simply click the No Change In Licensing 
check box on the licensing page of the Installation wizard. New licenses and changes to 
network licensing can be made after the installation using the License Manager. 

System Files 

There are no new system files for this release. 

New Additional Supplementary Files 

Details of all additional files supplied are supplied in Appendix A at the end of this 
document. 
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Pulsonix Spice Installation 
During installation of Pulsonix Spice, if updating from a previous version, there are 
changes to the installation folder which you should be aware of. 

For existing users who have not added their own models to Pulsonix, you can ignore the 
comments below. 

Pulsonix-Spice, in common with most applications, needs to store a number of values that 
affect the operation of the program. These are known as configuration settings. Included 
among these are the locations of installed model libraries, font preferences, colour 
preferences and default window positions. 

Some changes to the file structure have been made especially the structure of the files 
located in the application data path. Some of these changes have been made to 
accommodate Windows Vista User Access Control which write protects the Program 
Files tree. In particular the following has changed. 

1. The Application data directory path name has changed to include the version number 
“<your_application_data_folder>\Pulsonix\Pulsonix-Spice540”.  

2. The configuration file has moved to a subdirectory \Config under the application data 
path.This means you will need to set up your Options again in the simulator 
program, and set up your model paths again. 
The configuration file from the previous version will still be on your system in the 
text file “<your_application_data_folder>\Pulsonix\Pulsonix-Spice\v52\Base.sxprj”. 
If you cannot remember the options and model paths you had set up, they can be 
found in this text file in the [Models] and [Options] sections. 
If you have your own models installed into the Pulsonix environment, you need to be 
aware of this: 
To set up your model libraries again, from within the Pulsonix-Spice command shell. 
From the File menu, select Model Library and Add/Remove Libraries, or simply 
drag the folders from the Windows Explorer to the Pulsonix-Spice command shell. 

3. The default user script directory has moved to a location under the “My Documents” 
folder. This directory is not created by the installer but will be created by Pulsonix-
Spice when one of the script options under the File menu and Scripts is run. 
Either copy your own existing scripts to this folder, or change the scripts file location 
in the general options dialog.  

4. Because of the application data path name change, existing users will need to re-
inform the simulator about the model to Pulsonix Part associations.  
After you have installed the new Pulsonix program and have updated the Pulsonix-
Spice model library locations, you need to run the Simulator Setup facility as 
follows: 

 Run up Pulsonix and open any schematic design (or create a new one). 

 From the Simulation menu, use the Simulator and Simulation Setup option. 

 If you had changed the Part names for built-in models then reset these to the correct 
names using the top part of the dialog. It is unlikely that you changed these, but if you 
did and you cannot remember the correct names, you will be able to find them in the 
old text file “<your_application_data_folder>\Pulsonix\Pulsonix-
Spice\map_symbols.txt”. 
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 Press the Update Simulator Parts List button and exit the dialog by pressing OK 
when this is complete. 
 

5. If you created your own model to part associations  with the previous version, you 
will have a file called “<your_application_data_folder>\Pulsonix\Pulsonix-
Spice\user.cat”. If you want to keep these associations with the new version you will 
have to copy this file to  the “<your_application_data_folder>\Pulsonix\Pulsonix-
Spice540” folder, and rename the file to “user_v2.cat”.   
Now from the File menu, select Model Library and Rebuild Catalog option to 
update the catalog files contain the latest models and part associations. 

The new simulator will now be ready to use. 

Network Licensing Changes 
Network licensing has undergone a major rewrite to include new functionality. In addition 
to existing functionality, new options have been added to enable: 

 Loan licenses 

 Named domains and groups 

 License usage logging 

 Multiple and redundant servers 
If you are using the floating licensing scheme, new and additional documentation can be 
found in the Pulsonix Network Licensing Guide available on the product CD or on the 
Pulsonix web site. 
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Chapter 2. General Options 

Direct Printing to PDF 
The new plot to PDF output is used to write PDF format file with active annotation. Once 
the PDF file is created, you can hover your cursor over design items and properties of that 
item will be displayed. 

Writing the PDF files 

The PDF output is additional to the standard Windows driver and you do not need to 
install a separate driver for it. If you have a PDF Windows driver already installed, you 
can still use it. The Pulsonix PDF driver has the added ability of the active annotation 
which your standard PDF output will not have. 

The PDF output is accessed through the CAM Plot dialog and New or Edit when you 
create a plot. Simply select it from the drop down list of available output types. 
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Setting up the PDF output 

You can configure the PDF output using the Device Setup option from within the CAM 
Plot dialog. 

 

Active Annotation options available 

Active annotation options are available but only for Schematic designs. PCB designs are 
always ‘flat’ with no annotation. 

In a Schematic design, all pages in the design and hierarchy are plotted (including lower 
level hierarchical blocks). 

Using the PDF output 

Once the PDF file has been created and it is open, you can hove your cursor over design 
items, such as Components or connections. A small context menu is displayed from which 
you can view Properties of the item chosen. 
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Reload & Replace Part   
When performing a Reload, the option has a check box to allow you keep or remove local 
component attributes, attributes that have been added to that component instance. 

 

Highlight Selection 
Once a selection has been made in the design, from the context menu you can now 
Highlight the Selection. When you select away from this, the selection will still be 
displayed in the selection colour. Use Unhighlight Selection from the context menu to 
remove it. 
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Synchronise Design Changes    

Rearranged dialog 

The Synchronise Designs dialog has been rearranged to make synchronise choices more 
visible. 

 

Leave Tracks 

If components are to be deleted from the PCB, you will be presented with the option to 
Leave Tracks to the components as dangling tracks. Select the check box to leave them, 
or uncheck it to delete the connected tracks. 

 

Footprint Settings 

In the PCB Design Settings dialog under General, you can now choose to ignore specific 
footprint settings in the Schematic. This means if you define the footprint in the 
Schematic but then change it from the default in the PCB Design, you can use this check 
box to ignore the change. 

 

Find by Attribute Position 
In Find, changes have been made to the category Attribute to Item (by attribute), and a 
new category Attribute Position has been added. 
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The new category lists all attribute names (including in-built ones like <Component 
Name>) that have attribute positions in the design.  

Note: some of these attribute positions are hidden on items (like when a component name 
is unchecked in the properties dialog). A message will be shown if a hidden attribute 
position is found. Hidden attribute positions are found only after finding all visible ones. 

This category is required to make it easy to make global changes to similar attribute 
positions. For example, to change component names to use the same text style, or to 
change all testpoint names to the same layer. 

Mouse use in Dialog Grids 
Changes have been made to the functionality available within grids used in some dialogs, 
Technology and Layers for example. 

Using the wheel button (on the Intellimouse), you can now scroll up and down the list of 
items displayed where the list is longer than the grid visible. 

Using the Ctrl key on the keyboard, pressing this and rolling the wheel button, you can 
zoom in and out of the grid, like you can with Microsoft Excel for example as shown 
below. 

  
If you press and hold the wheel button pressed you can use the auto-pan option to scroll 
up/down and left/right depending on the mouse movement direction. 

Warning message if Type Font is not defined on the system 
On the opening of a design, you are now warned if a text style uses an unknown true type 
font. The warning message will tell you the font expected and the text style which uses it. 
If you wish to make a font replacement, use the Technology dialog and Text Styles to do 
this. Alternatively, acquire and install the appropriate Windows font on your system. 
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Move Horizontal/Vertical 
During Move and Move Corner, two new commands Move Horizontal and Move 
Vertical are available on the context menu. Selecting one of these restricts the item 
movement to that direction only. 

These options can be added to a shortcut key or can be used from the Move context menu. 
The commands can also be used directly on a selected item (so that you don't get the jump 
to grid when it is first moved).  

Note: This option will not work if you are moving on a special grid (Polar grid, snapping 
to Placement Sites or Construction Lines). 

 
From the context menu, select Move Horizontal or Move Vertical. 

 
A model cursor is displayed. During Move Horizontal, the movement of the cursor is 
restricted in the horizontal plane. 



 Pulsonix V5.0 Update   17 

Constrain Orthogonal Segment 
In previous versions of Pulsonix, single selected orthogonal segments were always 
constrained to move only in their perpendicular direction. There is now an option included 
–Constrain Orthogonal Segment, on the Move context menu to switch this off. Once 
off, this allows movement in any direction. 

 

Preserve Attached Segments 
During Move, a new option is available to describe how unselected segments attached to 
moving selected segments are altered. This is available on the context menu when Free 
Angle Adjoining Segs is switched off. 

 
If you leave this option unchecked, it will work as before in previous versions of 
Pulsonix, i.e. the attached segments are matched to a segment mode and altered thus. 

Select it to preserve the angle and far end point of the unselected attached segments. This 
is usually achieved by changing the length of the selected segment.  
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This is demonstrated during track editing. 

 

Rearrange Multiple Items 
If you select multiple free pads, vias, mounting holes (all with the same style) or 
Components (with the same footprint), the context menu displayed the Rearrange 
Multiple Items option. You can enter this mode by selecting the items or from within the 
Move option. 

Note: this option is not available if the items have track attached. 

If you wish to assign a shortcut to this option, it shares it with the Insert Multiple Items 
command/shortcut. 

This new option will allow you to rearrange the items in a grid that you specify with the 
Insert Multiple Items dialog using the controls provided. 

 
Once multiple items have been selected, the option sets all items’ mirror, rotation and 
layer flags to be the same as the item in the selection that your cursor is over. 
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Option Origins 
When working with option with the latch mode selected, you can now use two commands  
Use Option Origin and Place Option Origin. 

This option is used to create a temporary origin as an alternative to the symbol origin for 
use when Moving, Rotating or Mirroring the item. 

Once a latch mode has been selected from the toolbar, select Use Option Origin from the 
context to display a temporary origin. Use Place Option Origin from the context menu to 
change its location after it has been placed or if it needs to be moved.  The Use Option 
Origin can be selected from the context menu to hide it again. If the temporary origin is 
displayed, the rotate or mirror option will perform their task about this origin. You can 
also use Alt-Click as a shortcut to define the origin while in latch mode. 

 

Using the Option Origin in Move mode 

You can now use the Use Option Origin feature in the latched mode of Move. This 
works the same way as the Mirror and Rotate options shown above. This allows you to 
move any item, or multiple items, and define the origin for the move. 

 

 
The temporary origin stays visible during the move to make it easier to place it over 
existing items. 

This can be used, for example, to place a component by its first pad when its origin is 
already defined at its centre. This mode also allows you to reposition some imported 
shapes so that a particular point on the shape aligns up exactly with a known point in the 
design.  
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Show Placement Origin 

You can now show the placement origin whilst moving items. A new option command 
Show Placement Option is available on the context menu whilst moving. 

 
The origin displayed is a fixed size and shows the position displayed on the Status bar. 

View SCM & PCB Symbol Previews in Insert Component dialogs 
You can now optionally preview both Schematic & PCB symbols by selecting the check 
box on the Insert Component dialog. This preview check box is available in both 
Schematic and PCB design editors. 

 

Zoom in Preview Windows 

You can now use the wheel button on the mouse to zoom in and out of each of the 
Preview windows. Note, this functionality works in any Preview window. 

View Symbol Alternates in Preview Windows 

You now have the ability to select a different symbol alternate on the Insert Component 
dialog for the current symbol type, i.e. Schematic symbols in Schematic editor etc. You 
can also select different footprints while in the Schematic editor, this was available in 
previous versions but you can now see its preview using a drop down list of Footprint 
symbol alternates. 
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The Symbol: drop down list will show you the symbol for the current Gate: (Gate is 
shown when there is more than one gate for a Part). Where the Part is constructed of 
multi-gated symbols, the current selected gate is shown. Using the drop down list you can 
select another gate by letter or number and the alternate symbol for that gate shown. 

Next Symbol in PDC Window   

If you have purchased the Pulsonix Database Connection (PDC) product, you now have 
the ability to show symbol and footprint alternates in the preview window. If symbol 
alternates are available for the selected database Part, the Next Symbol and Next 
Footprint buttons will be highlighted. Selecting this will display the next symbol for that 
Part. 
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Preview Windows in Insert Connector Pin 

When using the Insert Connector Pin option, you can now check the Preview box to 
view a preview of the currently selected connector. As with the Insert Component dialog, 
you are also able to select the Schematic & PCB box to view both the symbol types. 

The Insert Connector dialog has been changed and is now the same style as the Insert 
Component dialog. 

 

Changes to Insert Connector Option 

Insert Component 

As well as using the existing Insert Connector dialog to add a connector, it is now also 
possible to add a connector from the Insert Component dialog. There is a Include 
Connectors check box in the filter section. 
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Arrangement of Components From Bin 
When dragging multiple components from the bin you can now switch the arrangement 
between horizontal and vertical placement. The Arranged Horizontally check appears on 
the context menu; uncheck it to arrange the components vertically. This option is 
remembered for the next time it is used. 

 

Part Editor Changes 

Improved Cut and Paste in Part Editor 

Significant improvements have been made to the Cut and Paste features within the Part 
Editor Pins and Gates pages. Improvements have been made to the cell selection and 
selection ranges. 

Using Copy and Paste To Edit Values in cells 

The values in this grid can be manipulated using the normal Copy and Paste techniques 
associated with spreadsheet applications such as Microsoft Excel. This includes the ability 
to copy and paste multiple rows and/or columns of data. One possible use would be to 
copy the pin data into an external spreadsheet to take advantage of advanced features such 
as sorting and filtering, then paste the modified data back in to the Part Editor. When 
pasting from an external source it is important to ensure that the data is arranged in the 
same order as the cells in the grid. 

 
The Copy and Paste commands are available from the Edit menu on the top menu bar or 
via the context menu. Alternatively, the standard Ctrl+C, Ctrl+V shortcut keys may be 
used. 

Selecting cells to copy or paste 

A single grid cell or a range of grid rows and/or columns may be selected for copy or 
pasting. By default, clicking on a cell causes that cell to enter edit mode indicated by a 
flashing cursor and any copy or paste will be directed to the edit control or dropdown list 
for that cell. If, rather than clicking, the mouse is dragged while the left button is held 
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down, a range of cells may be selected indicated by being shown in reverse highlight. 
This range of cells can now be copied or pasted as a whole. 

 
If a single cell has already been selected by clicking, it is possible to extend this into a 
range of cells. First, if the cell is in edit mode, press the <Enter> key to exit edit mode so 
the cell is simply shown as selected, outlined in bold. The selection may now be extended 
by dragging the mouse as described or by clicking with the <shift> or <control> keys held 
down. The <shift> or <control> key can also be used with the keyboard arrows keys to 
extend the selection. To quickly select an entire column click in its header cell. 

Pasting Values into the Grid 

When data is pasted into grid the values are subject to the normal constraints of the 
column into which they are being inserted. Any invalid values will not be inserted. For 
example, a value pasted into the Pin Name column must be a valid Pin Name defined in 
the Pin Names column of the Pins page. 

The Gate and Symbol Pin columns are read only and as such may not have values pasted 
into them although they may be selected and copied.  

The cells affected when pasting is dictated by the range of the cells copied not by the 
range of cells currently selected in the grid. So copying a 2 by 3 range of cells and pasting 
into the grid will paste a 2 by 3 range of cells starting at the top left cell of the currently 
selected range, subject to the constraints of the columns affected.  

One exception to this is when pasting a single value into multiple cells. All cells in the 
current range of cells will be set to the pasted value, again subject to the column 
constraints.  

Edit on Double-Click 

Throughout the system many dialogs use two-dimensional data grids to display 
information. By default, when interacting with one of these grids, clicking in a cell will 
immediately causing it to enter edit mode. On some occasions it may be preferable for the 
grid to behave more like a traditional spreadsheet and checking the Edit on Double-Click 
only option will cause a cell to only switch into edit mode when it is double-clicked rather 
than single-clicked. This can make it easier to select ranges of cells for example when 
using copy and paste in the Part Editor. 
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To enable this, check the Edit  on Double-Click box in the Options dialog under 
General. 

 

Symbol Alternates 

If the Copy selection in the Spreadsheet includes the Gate name where the Gate name is 
the alternate Symbol, provided the Part Editor Gate definition has the alternate listed, 
when the Paste of the selection is made, the Symbol Name will now switch to the 
alternate Symbol Name. 

 

Cell operation changes 

You can now use the Delete key in non-editing Part Editor grid cells where applicable. It 
will work for a single cell or a range of cells.  

Check Pin Mappings 

Within the Parts Editor there is now a Check Pin Mappings option on the 
Tools menu. This will report pins that have not been mapped to a gate or that 
have been mapped more than once and is useful for Parts with large pin counts 
such as FPGAs. 
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CSV Import file format into Part Editor 

The CSV import mechanism allows you to create Pin data for Parts in an external editor, 
Microsoft Excel for example, and to import this data into the Part. This may be beneficial 
if there are many pins or if the data needs to be manipulated first. 

CSV files are not Part specific, the data within one single CSV file can be applied to many 
Parts in the Parts library. 

In addition, for Import and Export of CSV files, also see the next chapter on new 
Schematic Options and FPGA support section. 

Opening the CSV file 

Once a Part has been initially created in Pulsonix, open it and then run Import Pin Data 
from the File menu. 

From the Open dialog, select the file for import. 

 
The normal rules of importing files applies, you must not have the file open at the time 
during import otherwise a ‘fail’ message will be displayed. 

File Format 

The CSV file can contain any of the following Part editor headings in any order: Pin 
Name, Logic Name, Pin Swap, Net Name, Pin Type, Pin Networks and user defined 
attributes. During import, the Pin Name is matched with the corresponding data, this 
means the Pin Name field is mandatory but it doesn’t have to be the first text entry in the 
CSV file though. 

The first line in the CSV is ignored as it is assumed to be a header. The Import option will 
read the headers to give it its structure. The headers can be in any order but their values 
must match the column titles in the Part editor. Column headers that don’t match the Part 
editor titles will be added as new Pin Attributes and the field entries added as the per pin 
values. 
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Using two commas will provide you with an ‘empty’ column field on import if you wish 
to miss out a field of data. 

As with normal text in Pulsonix, doubling the barring character will display names with a 
bar over the top of them. 

If a Pin Type is defined as No Connect, but the Net Name field is also defined, the Net 
Name will be ignored during input (the Pin Type will still be added though). 

If your CSV file contains an empty Pin Type field this will be defined as <Undefined> in 
the Parts Editor. You may also define the field especially as <Undefined> in the CSV file 
if you wish to define a pin type for all the pins, to help identify the pin type field for 
clarity. 

Basic Example 

Below is a basic example of the CSV input file: 
Pin Name,Logic Name 
1,LOGIC1 
2,LOGIC2 
3,RESET 
Complex Example 

Below is an example of a more complex CSV input file, this shows the addition of the Pin 
Order attribute field as well as Pin Swap, Net Name, Pin Type and Pin Network fields: 

Pin Name,Logic Name,Pin Swap,Net Name,Pin Type,Pin Network,Pin_Order 
1,IN1,2,ADD1,Ground,PNN1,A 
2,__IN,2,ADD2,No Connect 
3,IN2,1 
4,OUT,1 
7,,,GND 
14,VCC,,VCC 

CSV Export Option 

You can also export pin information to a CSV file using the Export Pin Data option from 
the File menu. 

Note: on Export, all Pin Type fields shown in the Parts Editor as <Undefined> will be 
output as this value into the CSV file. 

If your system is set to automatically run CSV files in Excel for example, once the CSV 
file has been exported, it will show in your spreadsheet: 
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At this point, you could edit the spreadsheet and re-import it back into the Part editor 
overwriting the existing data in that Part. 

FPGA Support in Pulsonix 

Overview 

Pulsonix includes additional features to aid the use of Field Programmable Gate Arrays 
(FPGA) and the increasing large pin counts associated with this type of device. Most of 
the major FPGA manufacturers provide their own tools for designing the logic and 
performing the pin assignments necessary with an FPGA. Interface features are provided 
that allow the integration of these tools and the information they generate directly in to the 
Pulsonix system.  

In phase I of this interface, Pulsonix will directly support formats for Altera’s Quartus II 
development system and the Xilinx ISE development system. Other system interfaces will 
be developed based on demand. Please contact our technical support desk or your local 
distributor if you would like to register your system. Pulsonix V5.0 will also write and 
read Part Pin CSV format files, this generic format can also be used in the FPGA 
environment. 

The FPGA interface is supplied as a standard interface within the Pulsonix environment 
free of charge. 

The flow of the process 

FPGA pin assignment data generated by manufacturers' tools can be imported into a part 
in the Pulsonix library. From there, it can be included with the part into the schematic and 
propagated forwards to the PCB layout. You can also start from within the Pulsonix  Part 
editor and export the Part pin data to a CSV format file for use with the FPGA tool.  

In parallel, you can develop your FPGA internal functionality using the Altera and Xilinx 
development tools. Once completed, or even part completed, write out an ASCII file. 
Changes to the FPGA pin out can be quickly reloaded into Pulsonix reducing the need for 
error prone manual editing.  
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Reports about pin swaps performed in the Pulsonix PCB will include additional FPGA 
information to assist with the process of updating the corresponding pin assignments in 
the FPGA design system. 

Multiple FPGA implementations may be retained as separate Parts in the Pulsonix library.  

The Pulsonix Part used in the design is then replaced using the new pin mappings to 
complete the process. This can be an iterative process and run multiple times to 
completion of the finished FPGA device. 

Importing FPGA Pin Data 

FPGA pin information is read into a Pulsonix Part using the Import Pin Data option. 

As some FPGA manufacturers provide pin assignments output suitable for loading in to a 
spreadsheet, an alternative to using the Import Pin Data option is to use the copy and paste 
facilities in the Part Editor to manually construct the FPGA pin data. If this method is 
used, is it important to remember to check the FPGA setting on the Part to take advantage 
of the additional FPGA features provide by Pulsonix. 

The Part to gate pin mappings may be checked by using the Check Pin Mappings option.  

FPGA Pin Data Formats Supported 

Altera PIN file format 

The Altera Quartus II software will automatically generate a PIN file as Part of the FPGA 
design process. The PIN file is an ASCII text file which contains pin assignments and 
other pin information for an FPGA design. 

Importing a Altera PIN file will assign the Pin Name/Usage values from the file to the 
Logic Name fields of the Pulsonix Part pins by mapping the Location values from the file 
to the Pulsonix Part pins' Pin Name fields. All other fields in the PIN file are currently 
ignored. 

Xilinx PAD file format 

A PAD file can be generated by the Xilinx ISE software as part of the FPGA design 
process. It is an ASCII file containing the I/O pad assignments and other properties. 

Importing a Xilinx PAD file will assign the Pin Name values from the file to the Logic 
Name fields of the Pulsonix Part pins by mapping the Pin Number values from the file to 
the Pulsonix Part pins' Pin Name fields. All other fields in the PAD file are currently 
ignored. 

CSV file format 

It is also possible to import (and export) Part pin data in standard CSV format. If the CSV 
includes the Logic Name field the Part will be set as a FPGA. 

Other formats 

The list of formats supported by Pulsonix is constantly being extended. If you have a 
format which is not currently supported, please contact our technical support desk to 
check if the format is under development or now available.  
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FPGA Pin Names as Pulsonix Logic Names 

Once loaded as Logic Name values attached to the pins on a Pulsonix Part, the FPGA pin 
names can be used as an aid to making the correct connections in the schematic and laying 
out the PCB.  

When you add a component using the Part to a schematic (or PCB) you can choose to 
display the Logic Name in the design as an attribute alongside the pin. If you prefer, you 
can choose to show the Logic Name as Part of the tooltip information displayed when you 
hover the cursor over the pin. The Logic Name is also shown in the Properties dialog for 
the component pin. 

Additional FPGA specific behaviour 

A part that is marked as an FPGA will trigger the following additional FPGA specific 
behaviour: 

Reloading revised Pin Data into a FPGA Part 

A second and subsequent import of the FPGA pin data will not simply add the FPGA pin 
names to the Pulsonix Logic Name fields again in the same manner as the original import. 
Rather, where possible, it will switch the Pulsonix pin name values, e.g. "A3", mapped to 
the Pulsonix symbol pins by comparing the FPGA pin names in the revised pin data file 
against the previous set of FPGA pin names held in the Logic Name fields of the Pulsonix 
part. This means that the logic representation in the schematic symbol can remain constant 
even though the pin out for the FPGA has changed. Only FPGA pin names that are unique 
will switched in this way, those that are common to multiple Pulsonix pins will be loaded 
using the same method as the original import. 

Reloading a revised FPGA Part into a design 

Pin out modifications loaded into an FPGA part must be subsequently applied to the 
schematic into which a component using the part has be loaded. This can be done using 
Reload from Library or Replace Part (depending on whether a new version of the 
Pulsonix part was created for the revised FPGA). A component that uses an FPGA part 
will be recognised as such and treated differently when mapping the pins (and their 
connected nets) to the revised Part.  

Normally a pin that is connected to a net is mapped to the new part using the Pulsonix pin 
name. For FPGA parts, the net pin will be mapped to the new part using the FPGA pin 
name, i.e. the Logic Name field on the Pulsonix part pin, thus if the FPGA pin out has 
changed on the new part although the schematic symbol representation remains constant, 
the net connectivity will change accordingly. For example, if the pin IC1.A3 (Logic 
Name:IO_L16P_2) is connected to net IOB, after the Reload the pin IC1.A5 (Logic 
Name:IO_L16P_2) could be connected to net IOB, with the Logic Name IO_L16P 
remaining the constant factor.  

The connectivity changes caused by the FPGA Part Reload/Replace in the schematic will 
be propagated to the PCB layout as normal by the Synchronise Design command.  

It is also necessary to Reload/Replace the FPGA part in the PCB design so the revised 
FPGA pin out is reflected on the component pads. However, unlike in the Schematic, the 
Reload/Replace will map net pins in the normal manner as the connectivity changes have 
already been applied via Synchronise.  
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The sequence of Import Pin Data, Part Reload/Replace, and Synchronise may be 
repeated as many times as there are revisions of the FPGA design.  

Additional Pin Swap information for a FPGA Part 

During PCB layout some pin swaps may occur. The Pulsonix Back Annotation report 
shows what pin swaps have been made. For an FPGA part, this will additionally show the 
pin Logic Name representing the FPGA pin name as a guide to making the equivalent 
change in the FPGA design system. 
e.g.  

 Swap Pad IC1.A3 (IO_L16P_2) and IC1.A5 (IO_L39P_3) 
   
Technology Changes 

Delete Unused command 

There is a new check box in Technology dialog to Delete Unused styles from the page. 

Available on Pads, Tracks, Text, Line, Hatch styles, Net Names, Net Classes, Pin 
Networks, Layer Spans, Layer Classes, Materials, Attributes and Groups pages. 

 

Design Rules Page 

In Version 5.0, a new tab has been added to the Technology dialog. Design Rules 
contains some new rules and takes some existing functionality to declutter other pages of 
the Technology. 
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Moved Features 

Testpoint Grid has been moved from DFM/DFT Rules page. 

All other rules on this page (other than the new ones) have been moved here from the 
Spacing Rules page. 

Die Pad Space – used when using the Chip Packaging Toolkit option. This is only 
available in the footprint editor and defines the minimum distance between die pads. 

New Features 

Testpoint to Component Space – used when testpoints are added to the design. 

Testpoint Land Size – used when testpoints are added to the design. 

Min Testpoint Count - new rule, used in Testpoint analysis; see later in this section 
under Testpoint Analysis. 

Testpoint Centre Space – new rule, used in Testpoint analysis; see later in this section 
under Testpoint Analysis. 
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Spacing Rules Page 

New Features 

Use Board Centreline has been added. When checked, it is used to ignore the real width 
of all board outlines. Checking would then be done up to the centreline of the board 
outline shape. 

 

DFM/DFT Rules Page 

New Features 

Min Probe Count per Net – used in Testpoint analysis; see later in this section under 
Testpoint Analysis. 

Probe On - used in Testpoint analysis; see later in this section under Testpoint Analysis. 
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Layers Page – Usually Plotted Option 

In the Technology under Layers, the new Usually Plotted check box under Plotting 
defines if the current layer would normally be plotted, if you uncheck this option, a plot 
will not be generated for this layer, or appear in the list of layers requiring a plot. It also 
will not appear in the Layer Stack Preview. It does not prevent you from manually 
creating a plot.  

 

Thermal Rules - Orthogonal Spokes 

When the Orthogonal Spokes check box is checked it causes spokes to be orthogonal to 
the pad shape. This has no effect on round pads, on other shapes the spokes take the 
shortest distance across the gap from the same point where the angled spoke would have 
started. When unchecked, the spokes simply follow the line from the pad centre 

 
The pads will be displayed like this: 

 
‘Normal’ spokes Orthogonal Spokes 
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Design Revision Analyser 
The Design Revision Analyser is used to compare two 'versions' of the same design to 
check for significant differences or changes between them. It can be used for example to 
help you identify what might have been changed between two revisions of a board when 
the original revision has been signed off for EMC purposes. 

 
Your current open document revision is known as the 'Master'. With this document 
(Schematic or PCB) open, choose the Design Revision Analyser option from the Tools 
menu. 

You then need to select the second document, the one to compare against. This is known 
in the report as the 'Other' document. 

Choose from the options on the dialog to specify what checks should be done, and how 
you want the report to appear.  

Component Logical Changes 

This checks for components being added, deleted or renamed, and component values 
being added, deleted or modified, in the same way that the Synchronise Designs option 
does when comparing a PCB against its corresponding Schematic. 

Net Logical Changes 

Checks for nets (and net 'nodes') being added, deleted or renamed, in the same way that 
Synchronise Designs does when comparing a PCB against its corresponding Schematic. 

Component Physical Changes 

Checks for corresponding components being moved, rotated, flipped, or having a different 
footprint or pads in different locations, or pads with different styles. 

Net Physical Changes 

Checks for changes in total track length, track segment positions and width changes, total 
copper area, copper segment positions and width changes, via positions, via layer spans, 
via styles. 

Design Level Physical Changes 

Checks for changes to the total area of boards, the 'segments' of all boards, the area and 
segments of design level (not net) copper, and free pad positions, layers and styles. 
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The Report Output 

With the HTML Format check box ticked, the report is generated as an HTML (web 
page) file, which should then open automatically in your default web browser if you also 
have the View Report check box ticked. This HTML report includes links between the 
sections to make it easy for you to navigate up and down the report. 

With the HTML Format check box unchecked, the report is written as a plain text file in 
the normal way that other reports are written. This will open in the application that is 
assigned on your computer to handle text files. 

Dynamic Attribute Value Substitution 
The attribute substitution capability has been extended to allow dynamic attribute value 
substitution based on the value of another attribute. A 'nested' attribute substitution value 
can now be indicated by adding an extra 'Attribute Substitution Character', e.g. %%% 
rather than the usual %%.  

This can be useful for achieving attribute switching based on the value of another attribute 
such as the built-in <Current Variant>.  

For example, in a design that is defined to have two variants; USA and EUROPE, the 
following design level attributes could be defined: 

USA_Stock_No="USA-1234" 

EUROPE_Stock_No="EUR-1234" 

Variant_Stock_No="%%%%%<Current Variant>%%%_Stock_No%%" 

Then, if the Variant_Stock_No attribute is displayed in the design, it would show the 
appropriate stock number value for which ever variant was currently active at that time. In 
the example below, the USA variant is shown and the values from the USA_Stock_No 
value plugged in. 

 

Attribute Substitution check box   

On all edit attribute value dialogs, there is now a Substitute Attribute... button. Use this 
to pick from a list of attribute names the attribute you want to substitute into the attribute 
value being edited. This prevents you needing to remember the substitution character. The 
substituted string will be pasted and therefore will replace any text already selected in the 
value being edited. 
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This can be used for Text Callouts for example. 

Environment Variables in Paths 
You can now use environment variables in paths in the folders dialog for use with the 
Library, Technology, etc. paths. This means that by switching environment variable 
values, you can switch all or some paths in one easy step. 

Adding Environment Variables 

Before being able to use environment variables in Pulsonix you will need to define them 
first. To do this you will need to edit the environment variables in the Control Panel. 

From the Control Panel, Systems page, click on the Advanced tab. Select the 
Environment Variables button. This page displays user variables and system ones. You 
should add local user variables. 

 
Use the Add button to add a new Variable name and value. The variable name will be 
the name used in Pulsonix to change the environment, the value will be the path for that 
environment. 

Click the OK button to add the variable. If you wish to edit it, select the name in the list 
and click the Edit button. 
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Using Environment Variables in Pulsonix 

In the Folders dialog in Pulsonix, choose the folder type to change and click the New or 
Edit button. Type in the name of the environment variable. Use the % character to delimit 
the variable, for example:  %Project_A%/Colours 

 
Switch file locations using environment variables, this can be done using the Control 
Panel or by using system scripts or batch files. If different locations use different servers 
or paths, this customisation can be achieved by changing one or more Windows 
environment variables, for example "ECAD_SERV" and "ECAD_ROOT". All Pulsonix 
paths or filenames are able to store and resolve such variables. These variables could 
contain UNC paths to avoid the use of fixed drive letters.  

CAM Plot Changes 

Scale Combined Plots 

You can now scale each part of a combined plot relatively. Previously this was fixed so 
that the ‘master’ plot had the scale factor applied. The plot scale is relative to the ‘main’ 
plot scale and not relative to it’s own true size. 

 
Once the combined plot has been scaled, the main CAM Plot tab page will show the scale 
in the cell under the main plot scale. This is only shown when plot scale is not 1. 
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CAM Plot to named Windows Printer 

In the plot wizard you can specify a specific printer to use by selecting the Printer Name: 
from the drop down list. By leaving the list set to <Default Printer> it will use the printer 
currently selected in the Setup dialog. You are warned if the selected printer is not 
available when you print. 

 
On the CAM Plot tab of dialog, the Windows printer name is shown next to the Windows 
printer, like Windows (Apple LaserWriter Plus 810) or Windows (eDocPrinter PDF Pro) 
for example so you can see which one is selected. 

 
The settings for the Windows printers are taken from the Windows setup page on the 
Plot Settings tab. 

Controls in Combined Plot 

You can now independently specify the style and variant on a combined plot. So, for 
example, you could plot the sheet outline in artwork, but the design as outline on the 
same plot. 

Formats Option to Named Folder 

In the Cam Plot Wizard under Process Type page, the old Insert Output Into Plot 
Report check box has been replaced with a Output Location list box containing three 
options: 

  CAM Plots Folder 

  Insert Into Plot Report 

  Reports Folder 
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This allows you greater flexibility when running report files from the CAM Plot option. It 
also allows you to append reports into the main CAM Plot report so that you have one 
single report. 

The Reports folder is the new option allowing the format file plot output to be saved with 
the other reports. Note, it will always take the plot name (not the format file name). 

 

New Warning if Electrical Layer is not plotted 

On entry to the CAM Plot dialog, it now warns you if an electrical layer is not being 
plotted at all. This is a warning if the electrical layer is flagged in the Technology Layers 
dialog as Not Usually Plotted. 

 
Once in the CAM Plot dialog, a plot can still be generated using the CAM Plot Wizard. 
If the option is exited and re-entered, the warning for this layer will no longer be 
displayed. 



 Pulsonix V5.0 Update   41 

Exclude Items By Named Group 

In the CAM Plot Wizard, you can now exclude items by named group. 

 

Report Maker 

New/Changed Commands 

List of Boards 

Used on a PCB Design, this lists each board in the design. For each board you can report 
the following: 

Area  

Extents 

Is Circle – this is a new command and allows you to test for the shape being a circle. It 
reports a value of True or False, you can then test this condition using the IF command. 
For example, if the board is a circle (True), report the Circle Radius. 

Is Selected – this reports True or False depending on whether a board is selected in the 
design or not, you can test this condition using the IF command. 

Length – this gives the total length of the perimeter centre line around the board 

List of Segments 

This new command lists each segment of the board. 

Is Arc - If writing out a shape segment that is an arc, this can test the arc condition and 
reports True or False. You can then test this condition and report the segment differently, 
output the arc centre for example. 

Start Position 

End Position 

Arc Angle - when testing Is Arc for example, you can then use Arc Angle, Centre or 
Radius instead of the Start and End positions as alternatives. 

Arc Centre 

Arc Radius 
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Is Arc Clockwise – The command reports True or False (True means the arc is 
clockwise). On the response of the this test, you can run a command, Text: Clockwise or 
Counter-Clockwise for example. 

Line Angle  - This reports the angle of the end points relative to the start point of the 
segment. In the example below, the angle reported for this particular segment would be 
270 (degrees). 

 
Length - this reports the length of the segment (if it is on an arc, the distance around the 
arc). 

Is Selected – this reports True or False depending on whether a segment is selected in the 
design or not, you can test this condition using the IF command. 

List of Cutouts 

List of Cutouts works through each board cutout within the current board (including 
special board cutouts, defined as areas). For each cutout, you can report the following: 

Area 

Is Circle – As with List of Boards, this is a new command and allows you to test for the 
shape being a circle. It reports a value of True or False, you can then test this condition 
using the IF command. For example, if the board is a circle (True), report the Circle 
Radius. 

Is Selected – this reports True or False depending on whether a cutout is selected in the 
design or not, you can test this condition using the IF command. 

Length – this reports the length of the perimeter centre line of the cutout. 

Plated Through – Area Cutouts can be plated, this command will report a True or False 
status, you can then test this condition using the IF command. 

List of Segments – A new command, see above. 

List of Attributes 

List of Attributes is now available for Boards. You can report the Attribute Name, 
Value, X Coord, Y Coord and (X, Y) coordinates. 

List of Drill Holes 

List of Drill Holes is used in List of Drill Sizes to report the position of each hole of that 
size. Within this list you can report the following: 
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Drill Diameter 

Drill Shape – This will report Round unless a special drill hole shape has been used. 

Position 

Length - only used for special drill holes where a hole length is required. 

List of Segments - as above, use “IF Drill Size | Drill Diameter Is Equal To Special” to 
spin through the drill shape and output the individual segments. 

Type 

Type is now available on List of Testpoints. The report results are part, doc symbol, 
star point, pad, mounting hole, via, component pad, component mounting hole and 
component via. 

Units Name 

Units Name reports the name of the current coordinate units. 

Selection 

The new Selection command allows you to select items in the design. This has sub-
commands for Select Item, Deselect Item, Deselect All, Select Item If Visible and 
Deselect Item If Visible. Useful for difficult selection situations, for example to select all 
components on side top with a certain attribute. Inserted reports in the design ignore the 
select command. 

Is Selected 

Is Selected can now be used on selected nets in the design. This allows you to report 
details of the selected nets. 

Changed Functionality: 

Variables – The Variables dialog now has Multiply By and Divide By as well as 
increment and decrement as possible actions available. 
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Pin Count Report 
A new Pin Count report is supplied. This provides you with details of the number of pins, 
testpoints, etc. and in particular, reports the pin limit and how close the design is to that 
limit. 
Component count 139 
Component Pad count 509 
Design Pad count 916 
Pin Limit Count 1425 
Unlimited PCB Pin Limit 
 

Notes Field for Error Markers 
There is a Notes field which can be edited in the Properties of an error.  

 
This is especially useful for reporting a decision for locking an error marker when signing 
off a design with errors still in it for example. The Notes field is available in both 
Schematic and PCB designs. 

These notes can be reported in the Report Maker using the Notes command on List Of 
Errors. 

Arc Radius/Diameter Improvements 
A new command, Enter Diameter is available whenever editing a circle, arc or fillet. 

 
When editing a Mitre or Fillet you can now type the exact radius or diameter (for fillets) 
using Enter Radius and Enter Diameter. This is available on all modes of this type. 
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Properties of Circle & Arc 
Properties of a selected Circle or Arc segment will also now show the circle Diameter 
next to the Radius. 

 

New Cost Option 

Access for Product Lifecycle Management (PLM) Systems 

Feature Overview 

Pulsonix V5.0 introduces the Pulsonix PLM product interface. The license enables PLM 
systems to communicate with Pulsonix using an interface mechanism and proprietary 
commands within the Pulsonix environment. 

The initial release phase will include support for to the Integrate PLM interface system. 

Future product releases will include additional systems support on request. If you 
currently have a PLM and wish to interface to Pulsonix, please contact our technical 
support desk or your local distributor. 
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Chapter 3. Schematic Options 

Connector Gate Swaps 
You can now perform a gate swap on a connector. You can already do pin swap, but this 
does not let you swap pins between components.  

For connectors in the Part Editor, on the Details page, you can now set Gates to be 
swappable using the Allow Gate Swap check box.. 

 

Pin Logic Tooltips 
Within the Options dialog and Interaction, there is an additional tooltip switch for 
showing the Pin Logic name on selected component pins. 

 
The Logic: name is shown on the tooltip when the cursor is hovered over the pin. 
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New Line in Net Pages Attribute 
For additional formatting of the Net Pages Attribute, from within the Design Settings 
dialog and Naming, you can now set the Newline After parameter to a value greater than 
0. This gives a new line after that number of pages (specified in the value), i.e. 3 will give 
you a new line after Page1,Page2,Page3 and then after Page4,Page5,Page6. 

 

Alternate Symbols for Connector Pins 
Connector Parts can now have alternative symbols defined for them, similar to gates in 
normal Parts.  

The alternative symbols can be selected using the Next Symbol option from the context 
menu when using the Insert Connector Pin option. You can also select any alternative 
symbols using Properties of the connector once added to the design. 

 

Selection of Buses 
Shift-select will now expand to select all connected buses. 
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Mark Net on a Closed Bus 
You can now use the Mark Net option on a closed bus. When the bus is selected you will 
be prompted to select which net to mark using the Choose Bus Net dialog. 

 

Multiple Symbol Representations in Parts 
You can now have multiple Symbol Representations in Parts. 

A Part Representation is a set of gates which can be added to a schematic. A Part can have 
more than one representation. For example, a pack of four gates could be represented by a 
single top level symbol, or as four individual gates. Each representation is independent of 
the others. There is no cross checking, so representations do not have to conform to a 
hierarchical structure, although this is likely to be the case. The first representation is the 
default, used when a component is first added to a schematic. 

Adding Part Representations 

From within the Part Editor, add your normal Symbol(s) to the Part. 

 
Select the Gate to add the representation to. 
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From the Insert menu select Representation. 

 
A ‘blank’ Representation is added to the Part. At the same time, the Insert Gates dialog is 
also displayed. 

 
From the dialog, select the Symbol: (2AND name or whatever yours is) and the number 
of gates you require and click the Add: button. 

The Representation now shows the four ‘internal’ gates of the main symbol. 
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Using Parts with Multiple Representations 

When adding to the design, you can use the Insert Component dialog to select the 
alternative representation of the Part. 

 
Once added, you can change the Representation using the Next Part Representation 
button on the context menu for a selected Component. 
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You can also change the Representation using the Properties dialog. 

 

New Cost Options 

DxDesigner Import 

Pulsonix V5.0 introduces the import filter cost option  for the Mentor DxDesigner format 
of Schematic designs and Schematic Symbols and Parts libraries. 

This is available as a cost option on a license. Please contact your local sales office for 
more information. 

Other variants of the DxDesigner format are also available for import, for example, the 
older ViewLogic ViewDraw. 

Import Designs 

Use the File menu and Open dialog to import Schematic Designs. To import DxDesigner 
format files, you must open the sub-folder \sch and select the top level design file with 
the file extension .1 Note: the Data Transfer Wizard cannot be used to import designs of 
this type. 

You are presented with the Import dialog confirming the format selected. Type the 
Design name if you wish to change the one presented. Under normal circumstances, the 
Technology file name will not be required. 

Check the Translate as True Type Fonts box if you wish to import the DxDesigner fonts 
as True Type fonts. You are also able to rescale the fonts during import if required using 
the Scale box (during import only and not afterwards in the design). Click OK to proceed. 
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Importing Libraries 

The Pulsonix DxDesigner Import option is looking for the .1 file extension when it 
imports Schematic symbols. Under the normal file structure of DxDesigner files, the 
symbols are stored in the \sym folder. 

Use the Import button on the Library Manager dialog to import the schematic symbols. 

The same schematic symbol file is used when creating Parts. The symbols or the 
schematic designs do not contain footprint information, this would need to be added from 
a separate source. 

Zuken System Designer SCM Import 

Pulsonix V5.0 introduces the import filter cost option  for the Zuken System Designer 
format of Schematic designs and Schematic Symbols and Parts libraries. The Zuken SD 
EDIF format should be exported from System Designer for import into Pulsonix. The 
normal Pulsonix import mechanisms of Open and the File Transfer Wizard are used. 

This is available as a cost option on a license. Please contact your local sales office for 
more information. 

Import Designs 

Use either the Data Transfer Wizard or the File menu and Open dialog to import 
schematic designs. To import System Designer format files, you must open the design 
files with the file extension .eds 

You are presented with the Import dialog confirming the format selected. Type the 
Design name if you wish to change the one presented. Under normal circumstances, the 
Technology file name will not be required. 

 

Import Libraries 

Use either the Data Transfer Wizard or the Import button on the Library Manager 
dialog to import the schematic symbols. 

The same schematic symbol file is used when creating Parts. The symbols or the 
schematic designs do not contain footprint information, this would need to be added from 
a separate source. 
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Pulsonix Spice Changes 
There are minor changes to the Pulsonix Spice product. The changes include some new 
models, examples and scripts (detailed at the back of this document in Appendix A). 
There are also changes to the simulator interface and simulator engine itself to introduce 
improvements. 

Pulsonix Interface Changes 

New Parameterised Device 

A new parameterised device is available: 

Delayed Switch 

Use the Part Browser, with the Spice Category set, or use Insert Component to add the 
part named Delayed Switch device. Editing the device with <F7> will bring up a dialog 
with 6 parameters: 

  

New Signal Sources    

Two new Signal Sources are available: 

Sine Tone Burst 

Generates a sequence of sinusoidal bursts with a user defined number of cycles per burst, 
burst frequency and tone frequency. 

Use the Part Browser, with the Spice Category set, or use Insert Component to add the 
part named Sine Wave Burst Voltage Source. Editing the device with <F7> will bring 
up a dialog with 6 parameters: 
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Parameter  Description 

Burst Freq.  Burst frequency 

Tone Freq.  Frequency of the sinusoidal tone 

Num Tone Cycles  Number of sinusoidal cycles in each burst 

Peak  Peak voltage 

Offset  Offset voltage 

Points Per Cycle  Minimum number of time steps in each sinusoidal cycle. 
Increasing this number will improve the accuracy of the 
simulation at the expense of simulation speed 

Swept Sine 

Generate a sinusoidal signal with linearly increasing frequency. 

Use the Part Browser, with the Spice Category set, or use Insert Component to add the 
part named Sine Wave Sweep Voltage Source. Editing the device with <F7> will bring 
up a dialog with 6 parameters: 

 
Parameter  Description 

Start Frequency  Starting frequency 

End Frequency  Frequency at the end of the ramp Interval Time taken to 
ramp from start frequency to end frequency 

Peak  Peak voltage 

Offset  Offset voltage 

Points Per Cycle  Minimum number of time steps in each sinusoidal cycle. 
Increasing this number will improve the accuracy of the 
simulation at the expense of simulation speed. 
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Editing Passive Devices 

You can enter Expressions for Passive devices directly. You can add curly brackets in 
normal dialog, the need for Shift-F7 is no longer required. This takes the parameter from 
this value at run time and uses it.  

 

dB and Phase Fixed Probes Improvements 

The Edit Probe dialog for dB and Phase fixed probes has been improved and now has full 
editing capabilities. 

 
There is a new Default box in the Persistence section. If Use Default is checked, the 
value used will be the value set in the general options in the simulator. This is changed 
using the File menu and Options, General... Select the Graph/Probe/Data Analysis 
sheet. Under Fixed probe global options the Default persistence setting is the value used 
here when default is checked. 

Curve Colour - If Define Own Colour is checked, the colour will be chosen 
automatically in a manner that tries to minimise duplicate colours on the same graph. 
Alternatively uncheck this box then use the Colour selection select a colour of your 
choice. In this case the trace will always have the same colour. 

Display Order (Digital Curves) - Enter a string to control display order for digital 
curves. Normally digital curves are ordered according to their title. The value supplied 
here will be used instead if not empty. To force the curve to be placed above other curves 
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that don’t use this value, prefix the name with ‘!’. The ‘!’ character has a low ASCII 
value. Conversely, use ‘~’ to force curve to be displayed after other curves. 

 Bode Plot Improvements 

db and Phase limits have been added under Vertical Limits and an additional check box 
to Disable Properties has been added. 

 

Bode Gain & Bode Phase plots 

New probes have been added for Bode Gain Plot, Bode Phase Plot and Bode Phase Plot 
(X -1). The Bode Phase Plot (X -1) probe selects a phase probe with 180 degree phase 
offset. 

db and Phase limits have been also been added to this probe (see above). 

If you want even more bode plot options you can use the new individual dB and phase 
bode plot probes. 

Note: unlike the standard Bode plot probe the above only create a single curve either dB 
or phase as specified, but you have the full range of options available to all other probes. 

Simulator Interface Changes 

The section below documents specific changes to the simulator interface: 

Save & Restore Session 

This saves the current schematics, graphs and simulation data for later retrieval. 
Schematics that have been edited will be saved in their current state even if the original 
file has not been updated. 

This feature allows the Pulsonix Spice simulator to be shut down and the machine 
switched off without the need to save work. 
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Gain and Phase Margin Functions 

Two new functions - GainMargin and PhaseMargin - have been added. These can be used 
with Performance Analysis and MC Histograms. These functions are implemented 
using the script based user defined function system. 

Stacking Curves 

This feature will separate curves so that they all have their own grid. Two options on the 
Curves menu are available for this, one operates on all curves in a graph (Stack All 
Curves), the other operates only on selected curves (Stack Selected Curves). 

Stimulus Specification 

A new feature has been added to voltage and current sources allowing much more 
sophisticated stimulus specification. This uses the PSpice derived REPEAT and 
ENDREPEAT syntax allowing PWL definitions to be specified with a repeating 
sequence. The original PSpice syntax has been extended to allow the specification of 
Sines and Pulses within the PWL sequence. This allows wave-shapes such as tone-bursts 
to be easily created. Further the Sine specification used in this manner has some 
additional parameters not available in the standard Sine source. These are “minpoints” 
which specifies the minimum number of points that may be used to fabricate the sine 
signal, and “ramp” which specifies a frequency gradient. This allow the implementation 
of swept sine sources. 

The new feature uses this syntax: 

Vxxx n1 n2 PWLS specification 
specification will accept the PSpice PWL syntax using REPEAT, ENDREPEAT and 
FOREVER along with the scaling parameters. Note: currently the PWL syntax (as 
opposed to PWLS) only accepts the fixed standard SPICE PWL syntax. 

 ‘M’ for subcircuits 

The ‘M’ multiplier parameter may now be applied to subcircuit instances. This is 
implemented by scaling all devices within the subcircuit and works for all analysis modes 
including noise. There is therefore no performance penalty specifying this parameter. 
However, not all devices support it and an error will be raised if a subcircuit containing 
unsupported devices is instantiated with M not equal to unity. Currently unsupported 
devices include all digital devices and the lossy transmission line. All other analog 
devices support this including the new PSP and Hicum models. 

In addition ‘M’ may be applied individually to all devices except those exceptions 
mentioned above. 

Important Note: because ‘M’ is now an implicit subcircuit instance parameter, its use as 
a regular parameter can introduce problems. For this reason you cannot use ‘M’ as a 
regular parameter unless it is also defined with the subcircuit definition, e.g.: 

.SUBCKT subname 1 2 3 params: M=1 
If you use the above, ‘M’ as a multiplier will be disabled and instead it will treated as a 
regular parameter. If the definition of M in the .SUBCKT line is omitted, an error will be 
raised if any attempt to access ‘M’ in an expression is made.  
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SCRIPTS in Netlists 

The Pulsonix Spice script engine has now been incorporated into the simulator. This 
allows a script to be called from the new simulator statement .post_process. This will call 
a specified script when an analysis successfully completes. In addition, the script code can 
be embedded in the netlist using the .FILE/.ENDF syntax. 

The above will work even if the simulation is called in non-GUI mode. 

SOA Enhancements 

The Safe Operating Area (SOA) feature has been extended as follows: 

1. Limit values may now use parameter expressions 

2. A per definition de-rating factor has been added and this can be defined using a 
parameter expression. 

3. It is possible to specify limits on the mean value during the course of the run. 

4. A report can be generated showing the margin within which all devices are operating 
even if they did not violate the absolute limits. This information is available via a 
script function if required. 

5. A .option setting can specify start and end times during a run over which SOA is 
active. 

Expressions in Graph Annotations 

You can put expressions enclosed in curly braces in graph annotation labels as well as 
plain text and angle bracket enclosed symbols. This permits more complex live displays 
based on cursor positions or curve marker positions. A simple example might be to 
display 1/Time in an x-axis cursor display to show frequency instead of period. 

Histogram Stepped Style 

Histograms are now displayed in a stepped style which shows the bin widths more clearly. 
This can be disabled in the Options General option if required. 

Small Graph Cursor 

The small cursor that was available in early versions of Pulsonix Spice has been 
resurrected. To define this, use the Cursors menu and Cursor Style... 

Additional Cursors 

You can now add additional cursors as well as the standard 2. To add more, use the 
Cursors menu and Add Additional Cursor.... There is no theoretical limit to the number 
that can be added, but practically the graph becomes difficult to manage with more than 
about 2. 

Data Point Markers 

Data point markers can now be displayed. To display them, from the Curves menu, go to| 
Show/Hide Points. 
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Colour maintained for Persistence=1 Curves 

When a probe has persistence set to 1, the curve displayed remains the same colour. 

Freeze Curve Feature 

A curve can be frozen so that it is not deleted in a persistence purge operation. That is 
when a fixed probe’s persistence is set to non-zero, a frozen curve will not be deleted to 
satisfy the persistence setting. 

There is no user interface for this feature, so set a curve as frozen, double click it, then in 
the Properties box double click Frozen and set to TRUE. 

CSDF Import (from PSpice) 

The waveform viewer can now read CSDF ASCII format data files which both PSpice 
and Hspice can export in this format. 

BITMAP Image Export 

It is now possible to export the schematic image in the bitmap formats PNG, JPG and 
BMP. Also, the method for writing out image files has changed. Previously this was done 
using the Save As... option from the File menu then select format using Save as type. 
This is now done using a new Save Picture... option devoted to saving exported image 
files. The same changes and additions have been made to the waveform viewer. 

Simulation “Started” and “Complete” command shell messages 

You can enable messages to be displayed in the command shell stating when a simulation 
was started and completed. This is off by default, to enable it type the following at the 
command line: 

Set DisplaySimProgressMessage 
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Chapter 4. PCB Options 

Construction Lines 
Construction Lines have been added to Pulsonix. This gives you the ability to add 
infinite lines and circles that other design items can snap to and can be used to easily 
construct accurate shapes. These lines can be created using a variety of functions available 
to aid, fore example, the centre of a triangle or arc or creating temporary intersects that 
you can use for creating complex shapes. Construction lines can be added to any design 
layer or can be given their own layer, and their own colour. 

Construction lines can be used in the Schematics editor as well as PCB designs. They can 
also be used in the Symbol editors and in the user defined Pad Shape Editor in PCB. 

Construction lines are not selected in Frame Select and are not counted in the total board 
area. They are also not plotted using an CAM plot outputs. 

Note: if using Construction lines in the user defined Pad Shape Editor it does not  
remember the construction lines after exiting; in this mode they are transient. 

What to use Construction Lines for 

Construction lines can be simply used as visible guide lines to see if items are in line, or 
can be used by options to add shapes, or snap items onto exact positions.  

 In Align you can align items using a construction line.  

 When using Add Polygon you can create a shape by using Use Construction 
Regions to merge together shapes defined by their surrounding construction lines and 
circles.  

 When editing a shape you can create a shape by using Follow Construction Lines to 
automatically place segments exactly on construction lines or circles.  

 In the Insert Shape functions you can snap the points in a rectangle, circle, triangle, 
line or polygon onto construction lines, or onto the intersection of construction lines 
using the Snap To Item option.  

 The above three methods can also be used when creating cutouts in shapes, or when 
merging shapes together.  

 You can use multiple horizontal and vertical construction lines to define a irregular 
matrix of points to be used as a grid in Move when using its Snap To Construction 
Lines option. This makes the construction line intersection points act as magnets to 
attract the moving item when it is near to them. If the item is not near to a 
construction line it is gridded normally. 
The snap distance that is used to determine if the moving item is close to a 
construction line, uses the value defined in the Placement Sites option (Settings 
menu and Design Settings, Placement Sites). 
Using construction circles for this enables you to define irregular polar grids.  
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How to Insert Construction Lines 

Construction lines are added to the design using the Insert menu and either Construction 
Line or Construction Circle options. 

 
Default construction lines settings are taken from the Settings menu, Design Settings and 
Construction Lines. You can set the default Layer on which the lines will appear. You 
can change this as you add the lines using Change Layer as you use them. 

 
Once in this option you can select different modes of operation from the context menu. 
The context menu can be used to switch between modes. 
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Swapping between Insert Construction Lines and Circles 

Without having to go back to the main menu, you can select the Insert Construction 
Circle option from the context menu (while adding a line) to swap modes to now add a 
circle. 

How to Insert Construction Circles 

After selecting Insert Construction Circle option from the main menu or swapping 
mode to this from the context menu, the context menu then changes to ‘circle’ modes of 
operation. 

 
Once the first point of the circle has been added, the context menu then shows more 
options. 
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Modes of creating Construction Lines and Circles 

All modes of operation are available from the context menu while in Insert Construction 
Line and Insert Construction Circle. From within one of these modes, right clicking the 
mouse reveals options available for construction lines. 

 

 

Adding Additional Construction Lines 

As well as using the Insert Construction Line command, you can also pick an existing 
construction line in the design and copy it. This can be done using the Copy command 
(from the menu or shortcut key Ctrl-C). You can also select an existing line and with the 
Ctrl key pressed, drag off the line to create a copy using the same angle as the original. 

If you copy an existing construction line using Ctrl-pick or the Copy/Paste or Duplicate 
commands, the ‘original’ line will be highlighted to indicate that it is the origin.  

 
The new line can be positioned with an offset using the Type Offset command (see 
below). With the original line highlighted, the copied line can be moved either side of the 
original. The Type Offset command will then work in that direction using the values you 
type in. This means the offset is always typed in positive values. 
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Snapping Modes 

To aid the addition of construction lines/circles, you now have different ‘snapping’ modes 
available to you. These snapping modes are also available while in other options, such as 
Move and Shape Editing etc. 

 Snap to Item 

Whatever mode is being used, when picking a position for the construction line to pass 
through there are two options available to snap the picked point onto an existing design 
item. - Snap To Item and Snap To Arc Centre. 

 
Check the Snap To Item option on the context menu to force the picked point be snapped 
to the closest part of the item beneath the cursor. If snapping to a construction 
line, the snap point will be further refined to use a construction line intersection 
point if one is near. 

 
If Snap To Item is being used, check the Snap To Arc Centre option to cause the 
construction line point to snap to the centre of a picked arc, rather than the nearest point 
on it.  

If the Snap To Arc Centre option is not being used, and an arc or circle is picked whilst 
adding a construction line, the picked point on the arc will first try to snap to the top, 
bottom, left or right most point on the arc if it is close enough. If this fails it will try to 
snap to the tangent point where the line would touch the arc (again if close enough to the 
picked point). Otherwise it will snap to the nearest point on the arc.  

Type Coordinate 

The Type Coordinate command displays the dialog into which you type the X and Y 
coordinates. This is useful for accurate positioning to construction lines. 
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Type Offset 

The Type Offset command displays the dialog into which you type the X and Y offset 
from the delta position, normally displayed on the status bar. The delta position is 
dependent on the operation being performed, but is usually the starting point. 

 

Horizontal and Vertical 

This mode adds two construction lines at once, shown as horizontal and vertical lines 
through the cursor position. Left click to pick the required position for the intersection of 
the lines. The new lines will be added to the design and drawn in the highlight colour. The 
next two construction lines will appear, showing the offset from the intersection of the 
highlighted lines on the status bar. 

 

Single Construction Lines – Horizontal, Vertical and Change Angle To 

The next three modes, Horizontal Line, Vertical Line and Change Angle To, add a 
single construction line at a specified angle through the picked position. As each line is 
added, it is highlighted and the next line is displayed on the cursor using the same angle as 
the previous line. The status bar shows the distance from the highlighted line. 

   
Use the Change Angle To sub-menu to alter the angle of the line currently being added. 
The menu shows all the thirty degree steps commonly used, or use the Enter Angle 
option to type the exact angle required. You can also set the construction line angle to 
match any straight line segment already in the design. Do this by using Ctrl-Click on the 
existing segment. The moving line will change its angle to the picked segment, and if the 
segment was a construction line it will be highlighted and the status bar altered to show 
the distance from it.  
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Use the Rotate By 90 option if you want a line that is perpendicular to the current line 
angle.  

If a previously added construction line is highlighted you can use the Type Offset option 
to set the exact distance from it for the line currently being added (see above for Type 
Offset). 

The line being added moves on the current chosen grid, which can be changed using the 
Change Grid option on the context menu. If a highlighted line is shown, you can use the 
Grid The Offset option to change the gridding so that the moving line moves in exact 
grid steps away from the highlighted line. This enables you to place two lines exactly a set 
amount apart, and is especially useful when adding angled lines.  

 

Along A Segment 

This allows you to select a shape segment to create a construction line along it. If the 
segment is an arc, a construction circle is created through the arc.  

This mode allows you to create construction lines, or construction circles, that travel 
along the centreline of the picked shape or track segment. Each time you pick a segment 
in the design, a construction line, or circle if an arc is picked, is added to the design.  
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This can be useful if you want to recreate the construction lines that were used to create a 
complex shape, and then use them to correct, or alter the shape. 

  
 

Through Two Points 

This mode allows you to define a construction line that passes through two picked points, 
usually used with Snap To Item checked to snap to two specific points on items in the 
design.  

For example, between two component centres: 

 
Or between the corners of two shapes: 

 
This is a two stage process as follows:  

 Click to pick the first point for the construction line to pass through.  

 A dynamic line will be drawn from the picked point to the current cursor position, and 
the status bar will show the current angle of the moving line.  

 Click to define the second point, and the construction line will be constructed through 
the two picked points and added to the design. You are now ready to add the next line.  

 By using the Snap To Item and Snap To Arc Centre options, you can add a line 
directly between two circle centres. 

 

 



 Pulsonix V5.0 Update   69 

Regardless of where you select on the circles, this mode will select both circle centres. 

 

Tangent 

This mode helps you create a construction line that is a tangent to a picked arc or circle 
from a picked point.  

 
This is a two stage process as follows:  

 Click to pick the segment arc or circle for the construction line to become a tangent to.  

 A dynamic line will be drawn from a tangent to the picked arc, to the current cursor 
position, and the status bar will show the current angle of the moving line. If the 
cursor position is within the arc sector the tangent is drawn at the point where a line 
from the arc centre passing through the cursor position touches the arc. 

 Click to define the point that the tangent is to pass through. The construction line will 
be constructed from the picked items and added to the design. You are now ready to 
add the next line. 

 If you want to add a tangent between two circles, first make sure that Snap To Item is 
on and Snap To Arc Centre is off. Then pick one of the circles, and move the cursor 
close to the required tangent point on the other circle. Click again and the picked point 
on the second circle will be adjusted to the actual tangent point. 

The example below shows both a tangent to circle edges and a tangent between the circle 
edge and a circle centre. 
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Bisect 

Use this option to add a construction line that bisects an angle, or bisects the line between 
two points. This option can be used on design items and other construction lines. 

If an angle is to be bisected.  

6. Check the Divide Angle Between Lines option on the context menu. The cursor will 
change the show you are dividing an angle. 

 

 
7. You can use Ctrl Click on an existing arc segment to immediately bisect its angle. 

In this case the construction line will be added and you will be ready to bisect 
another line.  

8. If not using the Ctrl key, click on an existing line segment to define the first line for 
the angle to be bisected. A temporary line will drawn through the picked line. Now 
pick the second line of the angle. A construction line will be added bisecting the 
angle between the two picked lines. If the picked lines are parallel then the space 
between them is bisected. You will now be ready to pick the next angle to be 
bisected. 

 
If you creating a bisecting line perpendicular to the line between two points:  

1. Uncheck the Divide Angle Between Lines option on the context menu in order to 
indicate it is a line you wish to bisect rather than an angle. The cursor will change the 
show you are not dividing an angle.  

2. Check the Divide Perpendicular option on the context menu to indicate the angle of 
the resultant line is to be perpendicular to the line between the picked points.  
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In the example below, the component centres were selected and the perpendicular 
line added through the centre. 

 

 
3. You can use Ctrl Click on an existing straight line segment to immediately bisect 

it. In this case the construction line will be added and you will be ready to bisect 
another line.  

4. If not using the Ctrl key, click on an existing point to define the first point on a line 
to be bisected. A temporary line will drawn through the picked line, perpendicular to 
the moving cursor.  

5. Now pick the second point. A construction line will be added perpendicular to, and 
bisecting, the line between the two picked points. You will now be ready to pick the 
next points to be bisected.  

If you creating a bisecting line between two points at a fixed angle:  

1. Uncheck the Divide Angle Between Lines option on the context menu in order to 
indicate it is a line you wish to bisect rather than an angle. The cursor will change the 
show you are not dividing an angle.  

2. Uncheck the Divide Perpendicular option on the context menu. The bisecting line 
will use the current angle displayed on the status bar.  

 
3. Click on an existing point to define the first point on a line to be bisected. A 

temporary line will drawn through the picked line at the current angle.  
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While in Bisect mode, if you wish to switch the line mode (between vertical and 
horizontal for instance), you must select the mode required from the context menu, 
then re-enter Bisect mode again from the context menu. 

 
4. Or you can use Ctrl Click on an existing straight line segment to change the angle 

of the bisecting line to the same angle as the picked line.  

5. Now pick the second point. A construction line will be added at the current angle, 
bisecting the line between the two picked points. You will now be ready to pick the 
next points to be bisected.  

Divide 

 This option uses the same interactive procedures as the Bisect option above, but adds 
multiple construction lines to divide the angle or line into multiple parts. As with the 
Bisect option, it can be used on design items and other construction lines. 

When the option is chosen, the following dialog is given to get the number you want to 
divide by. If you are already in the Divide option, simply select the Divide option again 
from the context menu to change the divide number.  

 
When the construction lines are added to divide the picked angle or line, unlike Bisect, 
lines will also be added at the extents of the angle or line. 

The example below shows two corners of the two components divided by 3 with the 
Divide Perpendicular switch selected. 
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The example below shows the same selection but with the Divide Perpendicular switch 
unchecked. The original line mode selected was Vertical before using Divide. 

 
The example below shows Divide by 3 on two selected straight line segments. 

 
In the same mode, if you Ctrl-pick the Arc instead of the two straight line segments, the 
divide will be performed on the arc centre. 
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Finding an Arc or Mitre Centre 

If you need to find an Arc or Mitre Centre, there is a simple method you can employ. 

In the picture below, we’ve already added one horizontal construction line (using either 
Horizontal mode or Select Along A Segment mode then rotating it by 90 degrees as the 
shape line is at 90 degrees and snapping it to the corner). 

We now need to add another construction line at 90 degrees to the other shape segment. 
The difficulty with this other line is that it is not orthogonal. 

In the Construction Line option, using the Along A Segment mode again, Ctrl-pick the 
angled segment. The construction line being added will snap to this line and mimic its 
angle: 

 
Now that the angle is the same as the segment, Rotate it by 90 degrees (use the <R> 
shortcut key). 

 
Click on the corner of the two shape segment to snap the construction line to it. 

 
The two construction lines cross at the arc or mitre centre point. We can show this by 
adding a circle to the construction line intersection: 
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Viewing/Deleting Construction Lines 

Construction lines can be added to any layers but it can be beneficial to create a separate 
layer to add them to. Using a unique layer, the layer name becomes available in the 
Colours dialog and on the Layers Browser. When defining a unique layer, the layer type 
should be set to Documentation. 

Construction lines are available as a display item on the Layers Browser list at the 
bottom of this dialog. This is shown under Show>>/Hide>> under Constructs:. 

 
You can delete all visible construction lines in the design using context menu command 
Delete Visible Construction Lines and as a command or shortcut key. 

 
You can also use the Delete Visible Construction Lines option whilst in the Insert 
Construction Line option from the context menu. 
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Using Construction Lines to create shapes 

Follow Construction Lines & Use Construction Regions 

When adding shapes, with construction lines in the design, from the context menu you can 
select that item to Follow Construction Lines or to Use Construction Regions. These 
options can be used when adding Shapes, Merging Shapes and adding Cutouts. 

 
Follow Construction Lines will allow the shape to snap to the nearest construction line 
and then follow the shape as you move the cursor along further construction lines. 

 
Use Construction Regions will allow a shape to mimic enclosed construction line shapes 
created, for example if you cross four lines to make a ‘box’, this will create you a box 
shape region.  

 
When adding a board outline for example and selecting this option, if you then click 
inside the ‘region’ it will automatically add you a box shape snapping to the construction 
lines. 
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Snap to Construction Lines 

Construction lines work like placement sites during placement when placing components. 
From the context men, you can select the Snap To Construction Line option. 
Components will then use the Placement Site distance value defined in the Options 
dialog under Placement Sites. 

 

Moving item on Construction Lines 

When moving components, you can also use the Auto Rotate mode to snap to 
intersections between circles and lines, this is available on the context menu. 

 
With Auto Rotate selected, components now snap to construction lines. This can be an 
intersection of lines: 

 
Or it can be along the lines themselves, auto-rotate adjusting the component’s rotation 
accordingly.  
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If you move off the construction line, the component will snap to the nearest grid point 
and back to its original orientation. 

 

DXF Import of Construction Lines 

If construction lines exist in the DXF file, they will be automatically imported. They are 
included if they appear in the file and would have been defined in AutoCAD.  

New Shape Functions 

Change Shape Type 

When you select a shape, you can swap from one type to another. For a shape type where 
Closed shapes are mandatory and the original shape is not closed, changing it from one 
type to another will close the shape. 

Select the Change Shape Type option from context menu or by using a shortcut key.  

 
Choose the New shape Type from the drop down list and click OK. 
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Change Shape Type for Text 

Change Shape Type is available on the context menu for some text items. It allows you 
to convert true type font text to copper or doc shapes. 

 
This allows conversion of company logos to copper for example, logos that were done 
with a special font. It will then also allow pour copper to pour up to true text outline. 

Add Corner  

You can add a corner into a line segment and do not want to use the Edit Segment 
operation, it can be performed by selecting the segment and using the Add Corner option 
from the context menu.  

  
Pick a segment and 
select Add Corner 
from the context menu. 

A corner will be added, and 
presented at your cursor for you 
to place. Click to drop the 
corner at the required location. 

Delete Corner  

Similarly you can remove a corner from a shape by selecting it and using the Delete 
Corner option from the context menu 

 
Pick a corner and select 
Delete Corner from the 
context menu. 

The corner is removed and a 
straight line added between the 
previous corner points. 
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Mitre / Unmitre / Fillet Corner 

Orthogonal corners can be converted to mitres or fillets by double clicking on a (90 
degree) corner or on an existing orthogonal mitre or fillet. The interactive Edit Mitre 
mode will be entered to drag the mitre or fillet to the required size.  

Alternatively you can now select a single corner, mitre or fillet and use the Mitre Corner 
or Fillet Corner options from the context menu. This is a single shot operation, but has 
the advantage that any angle corners can have a mitre or fillet generated. You will be 
presented with a dialog:  

 
Type the value for the radius or diameter of the mitre or fillet to be created. This is the 
radius of the circle that is tangent to the two lines that meet at the corner. 

 
You can remove any fillet or mitre back to a sharp corner by selecting it and using the 
Unmitre Corner option from the context menu. 

Trim & Extend Segment 

With a shape segment selected you can use the new Trim and Extend option from the 
context menu to trim the line or arc back to where another segment crosses it, or extend it 
to reach another segment. This option is also available on the Utilities menu. 

 
Once a track has been selected, from the context menu, select Trim or Extend Segment. 
A modal cursor is displayed. Select the segment you wish to trim or extend to. 
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These examples show how the one segment has been trimmed back to the shape and the 
other segment extended to meet the shape (in the right hand side example). 

 
You can also select segments to trim back to, to make them parallel: 

 

Replicate (Array Placement) 

Use Replicate to add multiple copies of selected items within the design (in an array 
placement). 

Select the item to replicate and from the context menu, select Edit> and Replicate. This 
option is also available on the main Edit menu and can be allocated to a shortcut key. 

 
Enter the required parameters into the Insert Multiple dialog. 
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The items are replicated: 

 

Replicate in Move 

Select a number of (same) items and from the context menu select Rearrange Multiple 
Items. The items can be with different rotations and mirror status. When using this 
option, whichever one the cursor is hovered over, the option will take the Rotation and 
Mirror status and apply it to all the selected items. 
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Enter the parameters into the Rearrange dialog. 

 
The items are rearranged and based on the status of the selected item. 

 

Restrict Movement 

While in Edit shape or Insert Track there is a new option is called Restrict 
Movement. This is a special single segment mode for use whilst editing a 
shape, the default is 45 degree mode. 
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Once enabled, there are additional features to Enter Angle, Enter Length and Grid the 
Length. 

 
Type Angle – this restricts the next segment to angle or perpendicular to angle. 

Type Length – this restricts the next segment to a fixed length. 

Grid the Length will lock the length of the moving segment to the same length as the 
grid spacing. This is noticeable when moving in non-orthogonal directions, i.e. 45 
degrees. 

 

Attached Dimensions & Attached Callouts 
You can now attach the end of Dimensions and Callouts to items. When the item is 
moved, the dimension moves with it and its displayed size adjusts without further user 
intervention. You are able to attach dimensions to most design items except for Text, Text 
Attributes, another dimension, Construction Lines, Callouts, junctions (like a ‘T’ route), 
unrouted connections, Vias, Teardrops and Origins. 
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Attached Dimensions 

There is a new command Attach Dimensions, available from the context menu whilst 
adding and stretching Dimensions.  

Check this so that when a dimension is snapped to an item it will be attached to it (if it 
can). 

 

Move 

Moving or changing the item will cause the dimension to be stretched (and have its 
measurement altered). 

Unattach 

Dragging the dimension line attached to an item will present a dialog asking if you want 
to un-attach the dimension. 

 

Highlight 

There is a new highlight colour in Colours to highlight the half of the dimension that is 
attached (or the whole dimension if fully attached). 
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Directional Dimensions   

You can now add horizontal or vertical dimensions with a directional appearance, for 
documenting multiple positions relative to a common point. 

 
When adding these types there is a new command, Directional Dimension available from 
the context menu.  

 
As soon as you have selected the dimension type (horizontal or vertical), select 
Directional Dimension from the context menu and then select the position of the start of 
the first leader line. 

You are now presented with the first ‘blob’ and dimension text. You can position the (0,0) 
first line length, or select the first item to be dimensioned, in which case, the zero line will 
be automatically made. If you move your cursor, you will notice the next dimension at the 
end of your cursor ready for positioning. This makes it easy to add a sequence of 
directional dimensions without having to pick the start point each time. You can position 
this over the existing line or move it to view it as required. Only one ‘arrow’ is displayed 
on the dimension line in this mode. 
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A directional dimension has no start arrow or start doc line and its default text position is 
next to the end arrow. If the dimensions measurement is 0 the end arrow is draw as a 
small filled circle the width of the arrow to indicate the common point. 

General Dimension Changes 

Dimension Arrow Size 

You can now specify the dimension arrow size by providing a width and length 
multiplier, multipliers of line style width used. 

 
The arrow line width is multiplied by these values to give the arrow head size. If the 
values are zero, no arrow heads will be drawn.  

The Design Settings Dimension page now has extra controls in the Arrows: section to 
set the default Head Width Multiplier & Head Length Multiplier. 
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Individual arrows can have their arrow head size changed by changing the multipliers 
using Properties dialog. 

Radial Diameter Dimensions 

Radial Dimensions can now display the diameter of the dimension (instead of the radius). 

 
If the radial dimension is set to display the diameter, then you can also specify that you 
want the arrow lines to cross the whole diameter (instead of just the radius). These new 
switches are in the Dimension defaults in a new section called Radial Dimensions. 

There is also a default switch for ensuring that radial dimensions have no arrow heads (to 
fit some standards).  

 
Individual radial dimensions can have these values changed using the dimension 
Properties page. 

Dimension Units Decimal Point  

You can now set the Decimal Point character used in Dimensions. This can be set in the 
Dimension Units defaults dialog, or individually on dimensions using Properties. 
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Auto Rotate Text  

Dimensions can now be set to have their "default" text auto-rotated to the angle of the 
dimension. 

 
There is a switch in Dimension defaults for radial dimensions only, but you can change it 
in the dimension text Property page for any dimension.  

If the auto-rotated text angle becomes greater than 180 degrees the text is adjusted by 180 
degrees to make it more readable. 

Attached Callouts 

There is a new command Attach Callouts, this is available from the context menu whilst 
adding and stretching callouts. Check this so when the end of a callout is positioned over 
an item it will be attached to it (if it can). Shift-select on a shape will attach a callout to 
the nearest point on a shape. 

As with Attached Dimensions, if you attempt to move the callout near where it is 
attached, a warning dialog is displayed. 

Attributes 

You can substitute any of the attributes of the attached item in the callout text. For 
example, when attaching to a component the text can contain the Component Name. 

For the Callout Text Properties, enter your text (Component, in our example) plus the 
substitute attribute name ( %%<Item Name>%% in our example). The text callout will 
then take on the item properties. 
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Hyperlinks 

If you select the callout text, the Execute Hyperlink command will use the text as the 
link. If the text contains c:\temp\document.pdf, it will run this PDF file. 

If you select the callout lines, Execute Hyperlink will use the hyperlink attributes from 
the attached items. For example, if attached to a Component and the component contains 
an attribute with the value http:/www.datasheets.com/12345.pdf then when run, it will 
execute this link. The attribute must be flagged as available to be run as a Hyperlink in 
the Technology and Attribute Names first though. 

DXF Export of Drill Letters and Symbols 
The DXF output can now export drill letters and Symbols using a selection on the DXF 
dialog. 

If you select the layer span layer i.e. <Through Hole>, you will get a drill drawing layer in 
the output (called _THROUGH_HOLE_DRILL_DRAWING_). This layer will contain any 
drill symbols and letters defined for the appropriate drills in the Technology file and Drill 
Sizes dialog. 

 

DXF Import Changes  
The dialog for DXF Import now includes the command Align DXF 0, 0 to Origin as a 
checkbox. This allows you to choose to align the 0,0 point of the incoming DXF data with 
either the Design Coordinate Origin or the current Relative Origin in your design. 
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Translucent Copper 
Pulsonix now contains the ability make copper transparent. This aids the visualisation of 
overlaid copper areas and other items under those copper areas, SMD components for 
examples. 

 
Control for Translucent Copper is available on the Options dialog and Display page. 
The slider on this dialog allows required level of translucency to be chosen. Once enabled, 
all copper will be drawn at the specified translucency. The Reset button will reset the 
slider to an optimum translucency position. 

 

Offset Serpentine 
You can now Allow Offset on a serpentine, which means that the serpentine section may 
be offset from the centreline of the track (in either direction. It will only be offset if it is 
not possible to add the track along the centreline. 
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A check box on the Serpentine routing dialog and in the Technology file and Net Class, 
Routing dialog will enable this. 

 

Pad oversize as a percentage 
In the Edit Layer Class dialog, you can now specify the Pad Oversize as a Percentage 
of the pad size as an alternative to specifying an Absolute size. Check the Percentage 
radio button and type in the value required. You do not need to add a % sign in the value 
field. 

 

Insert Multiple Items 
The Insert Multiple Items command has been added to the context menu for use when 
adding Mounting Holes and Footprint Vias in the footprint editor. 

Online DRC Update 
When using the Online Design Rules Check, the option now checks for a via in a pad 
when moving a component pad over a via or a via over a pad. 

Auto-necking into SMD Pads 
When using the autorouter, you can now specify whether the router will automatically use 
the alternative track style width to ‘neck’ down into SMD pads. 

In the router dialog, a check box Neck Tracks In Error is available. If a ‘fat’ track to be 
routed will cause a DRC error when entering an SMD pad, with this check box selected, 
the ‘thin’ track style can be used and the routing completed successfully. 
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The resultant tracks will look like this: 

 

Toggle Display Conns 
The existing option, Toggle Display Conns, is now called Display Selected Net Conns. 
This change has been made to make the name of the option more meaningful. 

This option is available on the context menu under Nets> and is available for selected 
components or connections. It will display the connection selected or all the connections 
attached to a component. 

 

New DRC Checks 
There are a number of new DRC checks available from the Design Rules Checks dialog: 

Testpoint under Component 

There is now a check for Testpoints under Components. 
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DRC checks on text 

You can now check for copper text outside the board outline and for mirrored text on a 
non mirrored layer (or non mirrored text on a mirrored layer). 

 
In the above example, the resultant error messages will be: 

 Copper Text Outside Board Outline (CT) At (31.24 87.63). Layer 'Top Electrical'. 

 Incorrect Text Mirroring (MX) At (30.73 85.85). Layer 'Bottom Electrical'. 
The design below shows both of these errors corrected. 

 

Use Board Centreline 

There is a new check box on the Technology dialog and Spacing Rules tab – Use Board 
Centreline. Use this option to ignore the ‘real’ width of board outlines when using 
Design Rules Checking. Checking would then be done up to the centreline of the shape. 
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Testpoint Analysis 

Testpoint Rules 

You can now specify additional constraints on testpoints (such as minimum pad size, 
distance between testpoint centres, whether you can test on vias, SMD pads, Through-
hole pads, etc.). You can define the number of testpoints to be added to nets in the design. 

You can also specify an attribute which defines the minimum number of testpoints 
required on a connected net (you can already specify this on a net class). This attribute 
can be on a net, pad or component even if the net class rule is set. 

If any of these rules (min number of TPs required) specifically define 0, then no testpoints 
are required on that net, otherwise it is the maximum of these minimum numbers (non-
numeric values have no effect). 

Automatic Insertion of Testpoints 

Using the Auto Insert Testpoints option from the Tools menu, will automatically 
allocate additional testpoints on a net. These can be added to existing pads, vias or new 
testpoint symbols, vias or parts can be added. 

The Automatic Testpoint Insertion dialog allows these testpoints to be defined and 
added. 

 
Using the Add To Unconnected Pads check box will allow you to add testpoints to pads 
which are not currently connected. 

Testpoint Type allows you to choose which type of testpoint you will add to the design 
and where they should be positioned. Unplaced testpoints are added to the Component 
Bin or placed Around The Board if this option is checked. 
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Testpoint Insertion Report 

Run from Automatic Testpoint Insertion dialog, the Testpoint Insertion Report lists 
nets which do not have the required number of testpoints (using the rules above). 

It suggests suitable existing nodes which could become testpoints and any DRC rules they 
would break. 

Summary 
------- 
 
  48 net(s) missing testpoints 
   0 net(s) with extra testpoints 
 144 testpoint(s) need to be inserted 
 
Nets With Missing Testpoints 
---------------------------- 
 
Net        Actual  Required 
 
DIFF1      1       2       
DIFF2      0       3       
DRIVE      2       1       
E1         0       3       
E12        0       3       
FAT        0       3       
GND        0       3       
High_speed 0       3       
HS         0       3       

New DRC Checks for Testpoints 

There are new checks available in the Design Rules Checking dialog under the 
Testpoints section. 

 
Testpoints – Unreachable Side – is an existing check but now categorised under the 
Testpoints section. 

Testpoints - Under Component - Checks that Testpoints are not placed under or too 
close to a Component. This check uses the component placement shapes to determine the 
extents of each component. Each testpoint must be more than the minimum distance away 
from all components on the probe side.  
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Testpoints – Centre to Centre – Checks that the testpoint centres are not too close using 
the Testpoint Centre space rule defined on the Technology Design Rules page. 

Testpoints - Minimum Points Per Net - Checks that the net has enough Testpoints, as 
defined in the Net Class Rules section of the Design's Technology data.  

Testpoint and Testability Report 

Run from the Output menu and Reports, two reports are available to report information 
about Testpoints: 

Testability Report –  this is an analysis report of the testpoints in the design. It also 
includes Testpoint DRC checks defined in the DRC Acceptance tests. This enables you 
to include this report in your CAM Plots batch as a final sign-off report for Testpoints. 

Testpoint Report – this reports the X and Y position, Side, Name and Net Name of each 
testpoint in the design. 

Insert Layer Stack Preview 
Within the Technology dialog under Layers and Layer Spans is the View Layer feature. 
This enables you to view the layer stack and via spans. In version 5.0 you are now also 
able to insert this into a PCB design as a documentation symbol using the Insert Layer 
Stack Preview option on the Insert menu. Where the Material and Thickness have been 
defined in the Technology, these values will also be displayed in the Layer Stack 
Preview. 

 
Default values for Layer:, Line Style: and Text Style: are defined in the Settings menu 
and Design Settings and Defaults, Report Symbol dialog. 

Once in the design you can change the properties of the preview using the Properties 
dialog. 
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The size of the overall layer stack preview doc symbol is determined by the text size used 
for the layer names within it. If you change the text style and size using the Properties 
dialog, the doc symbol used for the layer stack will be automatically resized bigger or 
smaller as appropriate. 

If you change the layer stack or via stack in the Technology dialog, you can update the 
doc symbol in the design by selecting it and clicking Update Layer Stack Previews from 
the context menu. You may have more than one layer stack preview in your design. 

Display Layer Stack Preview Command 

There is a new command to display the Layer Stock Preview without going through the 
Technology dialog. This is available as a shortcut key command and a command from the 
Run Command dialog - Display Layer Stack Preview. 

Toggle View Powerplane Templates Off/On 
When using the View Powerplane option, Pulsonix now automatically switches off 
Templates on powerplane layers. Templates are switched back on again after using this 
option (View Powerplane> Hide), again with a question dialog. 

 
Warning check boxes for both modes are available to pre-select in the Design Settings 
and Warnings option. 
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Square Ended Tracks and Backoff 
When using thick tracks into a thinner track using a ‘T’ route, if you wish the thick track 
to be backed off, you can check the Square Ended Tracks box on a Net Class under 
Routing. This now backs off at width changes and junctions as well as on pads and at 
dangling ends. Enabling Backoff Track Ends will cause tracks to end squared off. This is 
only applied to tracks which have sufficient length for the track to be backed off and the 
end squared.  

 
Design Rule Checking will take the square end into account, allowing tracks to end more 
closely to other obstacles than would normally be the case. At width changes and T-
Junctions, track ends are squared off, so there is no overshoot. Again, this allows 
obstacles to be placed slightly closer to the track end.  

Copper pour also takes these fully into account. 

Note that there is a drawing performance penalty when using square ends.  

 

Non-round Drill Holes - Slotted Pads 

Slotted Pads 

You can now define non-round drill holes. You can do this using the Edit Pad Style 
dialog from the Technology dialog and Pad Styles page or the using Define Pad Shape 
editor. Drill Holes then show as Special in the Technology file. 
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When editing pad styles, you can choose from the list of Drill Shapes available from the 
drop down list or you can create your own shape using the Define Pad Shape editor. 

 

Outputting non-round drills 

When post processing a layer span, you can specify if round and non-round holes will 
come out. Non-round holes will be milled.  

The Cam Plot Wizard now allows you to specify the Hole Shape: when the Excellon 
output is selected. 

 
Finger (Oval) shaped holes are milled using a single line of the appropriate width, 
rounded rectangles are milled using a drill of the corner radius. 
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If you require Rectangle shaped holes to be punched, your normal selection would be for 
Hole Shape: Round and for no additional output. It is assumed you will not mix punched 
and milled slotted holes. Punched holes would then be output through the Report Maker 
using the new List of Drills command and the commands within it. 

Pad Shape Editor Changes 
The Pad Shape editor now shows the pad exception shapes as well as the default shape 
and drill hole shape, you can edit, add, delete any of these shapes. 

 
In V5.0, the ability to see and modify the drill hole which you couldn't previously do has 
been added.  

Edit an existing pad style in the Pad Shape Editor and you can delete, resize, move or edit 
the red circle drill shape. You are able to delete it first then add a new shape (a Rectangle, 
for example) to draw in a slotted pad. If you then select it, you can use Change Layer to 
select a new special layer of <Drill Shape>, this specifies the shape to be the drill hole.  

If editing the pad shape, use one of the other layers to add a pad exception. You no longer 
choose a layer to exist but can add exceptions at the same time. 

 
The <Default Shape> entry shown means that the selected shape will appear on all the 
layers in the layer stack unless changed to a specific layer. 
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CSV Import of Gerber Apertures 
From within the CAM Plot dialog and Setup, Gerber, you can now opt to use a fixed 
format aperture table from a CSV file. Any attempt to use apertures that are not defined 
by this file will cause an error to be reported during plotting.  

To use this option, select the Fixed Aperture File check box and choose your CSV file 
using the Browse button. The file name selected will be displayed. 

 
Clicking on the Apertures button will display a list of the fixed apertures that will be 
used. 

When the Gerber output is run, if the aperture required doesn’t exist, the plot is not output 
and the report file will contain a list of missing apertures. 

CSV File Definition 

The CSV file should contain aperture definitions in a particular format. The first line can 
show the field names for ease of reference when editing the CSV file. The fields required 
are shown in this example: 

dcode,shape,width,length,cornerradius,rotation,hole,offsetx,offsety 
72,round,0.6mm,0.6mm,0,0,0,0,0 
73,round,1.4mm,1.4mm,0,0,0.9mm,0,0 10,square,60,60,0,0,32,0,0  

The default units are thou/mils, but you can use mm by appending "mm" to each value as 
shown in the example. 
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Change to ODB++ Output 
The ODB++ Output has been modified to allow slotted pads and board cutouts to be 
exported to be processed for routing.  

Select the layer required from the drop down list under Plated Board Cutouts. The drop 
down list will display Non-electrical Layer Class layers available for selection. 

 
When processed, a new layer will appear in the ODB++ file which will have a milling 
profile created for it. 

Changes to the High Speed Cost Option 

Diff Pairs - by layer Gap and Width 

Within the High Speed option, you can now define the gap used on Inner layers and Top 
and Bottom. Previously, you could only define the gap used for all layers occupied by the 
differential pair tracks. A change has also been so that when changing layers, not only is 
the gap changed but also the track width. The track width change relies on a new switch 
being enabled in the Net Class dialog. 

Differential Pair Gaps 

Within the Differential Pairs option of the Technology file, you can now define the pair 
Gap for the Top and Bottom layers, plus the Default. The Minimum Gap is the minimum 
distance the pair of tracks can be. This can be less than the normal Spacing rules for the 
nets (which would otherwise be the value used). This is the gap used by the Differential 
Pair Paired Track routing feature. You can define different values for the Top or Bottom 
Layer, if either of these values is Undefined, then they take the Default value. If the 
Default value is Undefined, then it takes the appropriate Track to Track spacing rule 
value. 
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Alternate Track Style on Inner Layers  

There is a check box on Net Classes dialog in the Technology file to use the alternate 
style when routing on inner layers (Alternate Style on Inner Layers). When a layer 
change is performed, with this switch set, the track width will automatically change to the 
alternate style. 

 
An example of a design using differential pairs might look like this: 
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Design Calculators 
The Design Calculators option can be accessed from the Utilities menu. This new option 
contains seven calculators, each accessed from a tab at the top of the dialog. Each of these 
calculators is explained in its own section in this document. 

Conversion Calculator 

This is a basic tool for converting numbers from one unit or notation to another.  

The Convert dialog appears when the tab is selected.  

 

Basic Conversion 

Choose the Type of value you are converting, Length or Angle for example.  

Enter the original value to be converted into the From: edit box, and select the units you 
are converting from using the drop down list to its right. Select the units you are 
converting to from the drop down list to the right of the edit box labelled To:.  

The converted value will be displayed in the To: edit box. It will also be entered 
automatically into the Floating Point Notation edit boxes to show the value using 
different numeric notations.  

Floating Point Notation 

Enter the number in the edit box using any notation you require. The number will then be 
shown in each of the different floating point notations. The Precision for the decimal point 
notation can be entered to set the number of decimal places shown after the decimal point.  

Note: Several of the other calculators will automatically set these values to their result 
when used.  
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Heat Sink Calculator 

This is a calculator based around the calculation of thermal resistance in a heat sink. It can 
be used to help with the selection of a suitable heat sink for a transistor or other 
semiconductor device that is mounted in a case that is then mounted on the heat sink.  

The Heat Sink dialog appears when the tab is selected.  

 
This calculator uses the basic formula: 

Total Thermal Resistance = Temperature Rise / Device Power  

The Temperature Rise is the rise from the ambient air temperature to the maximum 
device temperature, often called the junction temperature of the device. 

The Total Thermal Resistance is made up the following parts:  

 The "Junction to Case" thermal resistance for the device.  
This figure can usually be obtained for the device from the manufacturers data, or can 
be calculated from the device case temperature.  

The "Case to Sink" thermal resistance of the thermal interface material between the device 
and the heat sink. 

This is normally either a layer of thermal paste (thermal compound): 



 Pulsonix V5.0 Update   107 

 
or more likely an insulating washer with thermal paste either side: 

 
 The thermal resistance between the heat sink base and the ambient air. 

Using the dialog 

First select the value you want calculated using the radio button on the appropriate 
section. 

 Device Power 

 Temperature Rise 

 Heat Sink Thermal Resistance 
The value being calculated will become a read only box. Enter the values in the other 
sections to produce the result. The result will be blank if not all the required values are 
entered. 

Once you have calculated the required result, you can switch to the Conversion 
Calculator tab to see the result in engineering or scientific notation. 

Note: These calculations are approximations, and should not be used if a high degree of 
accuracy is required.  
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RLCF Calculator 

This calculator page represents the relationship between Capacitance, Resistance, 
Inductance and Frequency in a basic RLC circuit. An RLC circuit (also known as a tuned 
circuit or a resonant circuit) is an electrical circuit consisting of a resistor (R), an inductor 
(L), and a capacitor (C), connected in series or in parallel. You can use this calculator to 
calculate any two of these values given the other two. 

The Basic RLFC dialog appears when the tab is selected. 

 
Press the Clear All button to clear all four values, ready for you to use. Enter the two 
values you know and the other two values will be calculated in read only boxes. 

These calculations are based around the following two generally known equations: 

 
and 

 
where R is the resistance, C is the capacitance, L is the inductance and f is the natural 
frequency of the tuned circuit. 

Scientific Calculator 

This is a scientific calculator with the ability to use values from picked PCB design items. 
The calculator performs basic arithmetic, such as addition and subtraction, as well as 
functions found on a scientific calculators, factorials and logarithms for example.  

The Scientific dialog appears when the tab is selected. 
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Basic Use 

The calculator works the same way as a hand held calculator. 

 To use the calculator 

1. Click on the digit, sign and decimal point buttons to enter a number. The number will 
be displayed in the Register at the top of the calculator. Use the Backspace key if 
you make a mistake whilst entering the number.  

2. Click on an operation button, + to add, - to subtract, / to divide, or * to multiply.  

3. Enter the next number in the calculation. 

4. Continue to press operators followed by numbers until all numbers have been 
entered.  

5. Click on the equals button to give the result in the register. For example, 4 + 5 + 2 * 
3 = should give the result 33. 

You also can enter the digits and operation keys directly from the keyboard, and copy and 
paste numbers from elsewhere in this application, or from other applications, to the 
register using standard windows cut/copy/paste operations. 

At any time use the C (Clear) button to clear the register before entering numbers, or use 
the AC (All Clear) button to clear the register, all memory and the current operation. 

Scientific Operations 

The group of buttons to the right of the number buttons perform scientific calculations on 
the numbers you enter. Some of them are single click calculations on the number in the 
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register, and some need another number to complete the operation followed by an equals 
to present the answer. PI enters the pi constant into the register, ready for the next 
operation. The trigonometric functions operate on numbers in degrees. 

Some examples:  

 Pressing "2" followed by "x^3" performs 2 to the power 3 and the result 8 is placed in 
the register. 

 The sequence "5", "x^y", "4", "=" performs 5 to the power 4 and the result 625 is 
placed in the register. 

 The sequence "6", "4", "nth root", "3", "=" performs the cube root of 64 and the result 
4 is placed in the register. 

 Pressing "4", "5" and "tan" calculates the trigonometric tangent of 45 degrees, and the 
answer 1 is displayed. 

Trigonometric Operations 

Check the "Inv" box to change the trigonometric operations to perform the inverse, or arc 
functions. For example, use the sequence "Inv" "1" "tan" to perform the arctangent of 1, to 
find which angle gives a tangent of 1, so the answer 45 is displayed.  

Check the "Hyp" box to change the trigonometric operations to perform hyperbolic 
operations. For example, use the sequence "Hyp" "1" "tan" to perform the hyperbolic 
tangent of 1 giving the answer 0.761594 ( which is pi/4). Use "Inv" and "Hyp" to 
calculate the inverse of the hyperbolic function.  

Note, if you know an angle in radians and want to perform a trigonometric function on it, 
you can convert it to degrees using the Conversion Calculator and paste the converted 
value into the register to perform the operation.  

Logarithms 

Use "log" to find the base 10 logarithm of a number and use "ln" to find the natural 
logarithm. Checking the "Inv" box makes "ln" perform the exponential of the number in 
the register.  

Memory Operations 

The group of buttons in the Memory box allow you to save numbers to one of five 
memory locations, and recall these numbers when they are required at a later stage in your 
calculations. First select which of the five memory fields you will be using, and then press 
one of the memory buttons as follows.  

 Click MS (Memory Store) to copy the number from the register to the chosen 
memory field.  

 Click MR (Memory Recall) to copy the number from the chosen memory field back 
to the register.  

 Click MC (Memory Clear) to set the current memory field to zero.  

 Click M+ (Memory Add) to add the number from the register to the chosen memory 
field.  

 Click M- (Memory Subtract) to subtract the number in the register from the chosen 
memory field.  
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Statistical Operations 

The group of buttons in the Statistics box allow you to enter data in the form of a series 
of numbers, and calculate basic statistical information on the data. 

 To use the statistical operations 

1. Press the Sta button to enter Statistics mode. In this mode Stats will be displayed to 
the left of the register, and all the statistics buttons are enabled.  

2. Enter a number into the register and press the Dat button to add it to the data list. 
Repeat this for each number in the data series.  

3. When all numbers have been entered you can use one of the statistical operations.  

4. Click the Sum button to show the sum of the data.  

5. Use the Ave button to display the average of the numbers.  

6. Use the SD button to show the standard deviation of the data.  

7. Use the s button to show the sample standard deviation of the data.  

8. Press the Sta button again to exit the Statistics mode. The data will be cleared, ready 
for next time.  

Design Item Data 

This is available when editing PCB designs or PCB symbols. The Item Data box has a list 
of numerical information from the selected design item. To use this data, click on the item 
of interest in the list and use the To Memory button to store the selected value in the 
currently selected memory field, or use the To Register button to copy the number to the 
main register at the top of the calculator.  

Use the Length Units and Precision controls to change the way the design data is 
displayed in the list only.  

To change the item that information is displayed for, move the cursor out of the dialog 
and you will be presented with a calculator cursor. Use this to pick on the next item from 
the design. Keep the shift key pressed down to select whole shapes or tracks, or keep the 
control key down to just select a position instead of a design item. If you can not see 
enough of the design, use the Hide button at the top right of the dialog to hide the dialog 
until the mouse key is clicked. Pressing the Escape Key, or the cross at the top of the 
dialog will exit the calculator picking mode back to normal select mode.  

You can use the picking to measure the approximate distance between two picked points. 
After the second pick you will find Picked Distance and Picked Offset in the item list. The 
distance is the direct line between the picked points and the offset gives the X and Y 
coordinates. Keep the control key down to avoid items while picking if you only want to 
see the point information.  

Track Impedance Calculator 

This calculator calculates the characteristic impedance of a unit length PCB track for a set 
of common track geometries, or it can be used to calculate the required track width given 
a known approximate impedance value. 

The Track Impedance dialog appears when the tab is selected.  
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Track Geometry 

There are two controls that define the track configuration to be used in the calculations.  

First drop down the PCB Track Geometry list at the top of the dialog and choose the 
geometry that matches your track situation.  

Then use the check box below the list to select whether you want the calculation for a 
Differential Track Pair or a single track.  

The diagram in the dialog will be changed to show the track configuration you have 
chosen.  

What to Calculate 

Drop down the Calculate list at the top of the dialog and choose which value you would 
like to calculate. The controls in the Inputs section will alter to provide the inputs for the 
calculation you have chosen and the Result section will display the chosen value. 
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Inputs 

The controls in this section will be changed to match the chosen configuration and each 
will include a label in brackets referring to a label on the diagram.  

Enter the correct values to generate the required result. Make sure the units drop down list 
is correct for the values you have entered.  

If you are calculating the track impedance, you can enter the Track Width by picking on 
a track in the PCB design. To do this, move the cursor out of the dialog and you will be 
presented with a calculator cursor. Use this to pick on the track in the design and its width 
will be automatically entered into the dialog. If you use shift click to select a whole track, 
the largest width will be used. If you can not see enough of the design, use the Hide 
button at the top right of the dialog to hide the dialog until the mouse key is clicked.  

The Track Spacing is only presented for differential paired tracks and is the gap between 
the track pair. This cannot currently be extracted from the design.  

If you are calculating the required track width, you will be presented with the 
Characteristic Impedance control to enter the known value. 

Results 

This section shows the results of the calculations using the formulas listed below. Some 
calculations have constrains on the relationship between parameters and, if these are not 
met, an error message is shown on the top line of the Results section. The message will 
show the relationship and state a minimum or maximum value.  

Once you have calculated the Characteristic Impedance, you can switch to the 
Conversion Calculator tab to see the result in engineering or scientific notation.  

Formulas 

The formulas used are taken from "The Design Guide for Electronic Packaging Utilising 
High Speed Techniques" IPC-2251 document. 

NOTE: These calculations are approximations, and should not be used if a high degree of 
accuracy is required.  
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Note: These calculations are approximations, and should not be used if a high degree of 
accuracy is required.  

References 

"The Design Guide for Electronic Packaging Utilising High Speed Techniques" IPC-2251 
document  

"PCB Impedance Control: Formulas and Resources", by Doug Brooks.  

Based on the "PCB Trace Impedance Calculator" from the University of Missouri-Rolla 
EMC Laboratory.  

Track Width Calculator 

This calculator represents the relationship between the track width, the current applied to 
it and the temperature rise when that current is applied. Given any two of these values the 
third can be calculated. You can enter the track width, length and layer by picking on a 
track in the design.  

The Track Width and Resistance dialog appears when the tab is selected.  
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What to Calculate 

Drop down the Calculate list at the top of the dialog and choose which value you would 
like to calculate. The controls in the Input section will alter to provide the inputs for the 
calculation you have chosen and the Result section will display the chosen value.  

Inputs 

The values in this section are required to perform the calculation.  

Select the Track Layer. Choose whether the track is on an outer layer, or an inner layer of 
the board. The formula uses curve fitting following the IPC-2221 guidelines, which uses a 
different constant for tracks on outer and inner layers. 
You can also enter this value by picking on a track in the PCB design. To do this, move 
the cursor out of the dialog and you will be presented with a calculator cursor. Use this to 
pick on the track in the design and its side will be automatically entered into the dialog. If 
you can not see enough of the design, use the Hide button at the top right of the dialog to 
hide the dialog until the mouse key is clicked.  

Enter the Track Thickness and select the units of the value being entered. This is the 
thickness of the copper used for the track. You can choose to define the thickness using 
ounces per square foot, which we convert to thickness using 1.378 thou per oz.  

If calculating the Current or Temperature Rise the Track Width is required. Enter the 
value and select the units of the value being entered. You can also enter this value by 
picking a track segment in the design using the method mentioned above. If the whole 
track is selected (by holding the shift key down) the maximum width on the track will be 
entered.  

If calculating the Track Width or Temperature Rise the Current to be applied to the track 
is required. Enter the value in amps.  
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If calculating the Track Width or Current the expected Temperature Rise the track will go 
through is required. Enter the value in degrees Celsius.  

Resistance Inputs 

The next three parameters are only required if the Track Resistance, Voltage Drop or 
Power Loss are required.  

Enter the Ambient Temperature of the board in degrees Celsius.  

Enter the Track Length and select the units of the value being entered. You can also enter 
this value by picking a track segment in the design using the method mentioned above. If 
the whole track is selected (by holding the shift key down) the total track length will be 
used, otherwise the length of the selected track segment will be used.  

Enter the Copper Resistivity. If you don't know the Resistivity of the copper, it can be set 
to the default value of 1.7e-006 by pressing the Use Default button.  

Results 

Once legal values have been entered for all input sections the result will be automatically 
calculated. The fields will be left blank if not enough information has been entered. The 
formulas used to generate these results are detailed below.  

Formulas 

The formula used to represent the relationship of the three values (Current, Width and 
Temperature Rise) is as follows:  

 
where:  

I is the Current applied to the track in amps.  

T is the Temperature Rise above the ambient, in degrees C.  

A is the cross section area of the track in square thou. This is the Track Width times the 
Track Thickness.  

k, B1 and B2 are constants determined by applying least squares fit and multiple 
regression techniques to actual measured PCB data for different track widths and currents, 
such that the difference between the actual temperature rise and the calculated value using 
the constants in the above formula is minimised. The Doug Brooks paper on 
"Temperature Rise in PCB Traces" goes into this technique in more detail. The constants 
we will use are taken from the IPC-2221 design standard for PCB track widths, which 
uses curve fitting to estimate the following values:  

B1 = 0.44 
B2 = 0.725 
k = 0.024 (for internal layers) 
k = 0.048 (for external layers)  

The formula for track resistance used in this calculator is:  

Resistance = ((Resistivity * Length) / Area) * (1 + TC * (Temp - 25))  

Voltage Drop = Current * Resistance  



 Pulsonix V5.0 Update   119 

Power Loss = Voltage Drop * Current  

where:  

Resistivity is the copper resistivity entered in the dialog, and defaults to 1.7e-006.  

Length is the Track Length entered in the dialog.  

Area is the track cross-section area mentioned above.  

Temp is the Ambient Temperature plus the Temperature Rise, both from the dialog.  

TC is the linear temperature resistance coefficient of copper and we use the value 3.9e-
003 ohm/ohm/C taken from the last reference below.  

NOTE: These calculations are approximations, and should not be used if a high degree of 
accuracy is required.  

References 

"Constructing Your Power Supply - Layout Considerations", by Robert Kollman  

"Temperature Rise in PCB Traces", by Doug Brooks  

The IPC-2221 design standard for PCB track widths.  

"Temperature coefficient of resistance" - by John N Fox  

Via Resistance Calculator 

This is a calculator to calculate the resistance, voltage drop, power loss and thermal 
resistance of vias in a PCB design. It has the ability to take the hole diameter from a via 
selected in the design.  

The Via Resistance dialog appears when the tab is selected.  
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Required Inputs 

The values in this section are required to calculate the thermal resistance and the 
resistance for the via.  

Enter the Plating Thickness of the copper the via is plated with, and select the units the 
value being entered is using. You can choose to define the thickness using ounces per 
square foot, which we equate to thickness using 1.378 thou per oz.  

Enter the Hole Diameter of the via. This is the drill diameter before plating is applied. 
You can also enter this value by picking on a via in the PCB design. To do this, move the 
cursor out of the dialog and you will be presented with a calculator cursor. Use this to 
pick on the via in the design and its drill size will be automatically entered into the dialog. 
If you can not see enough of the design, use the Hide button at the top right of the dialog 
to hide the dialog until the mouse key is clicked.  

Enter the Via Depth, i.e. the length of the via through the board.  

Optional Inputs 

The Resistivity in this section is required for calculate the via Resistance, and the applied 
Current is required to calculate the expected Voltage Drop and resultant Power Loss.  

If you don't know the plated copper Resistivity, it can be set to the default value of 1.9e-
006 by pressing the Use Default button.  

Results 

Once legal values have been entered for all input sections the results will be automatically 
calculated. The fields will be left blank if not enough information has been entered. The 
formulas used to generate these results are detailed below.  

Formulas 

The formula for thermal resistance used in this calculator is:  

Thermal Resistance = (Thermal Resistivity * Via Depth) / Via Area  

where:  

Thermal Resistivity for plated copper is assumed to be 0.249 cm-K/W (at a temperature of 
300K)  

Via Depth is the length of the via through the board, entered directly in the dialog.  

Via Area is the cross section of the plating, defined by (PI * (Drill Diameter - Plating 
Thickness) * Plating Thickness)  

The formula for via resistance used in this calculator is:  

Resistance = (Resistivity * Via Depth) / Via Area  

Voltage Drop = Current * Resistance  

Power Loss = Voltage Drop * Current  

where:  

Resistivity is the plated copper resistivity entered in the dialog, and defaults to 1.9e-006.  

Via Depth and Via Area are as mentioned above.  
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Current is the current applied to the via in amps, entered directly in the dialog.  

NOTE: These calculations are approximations, and should not be used if a high degree of 
accuracy is required.  

References 

"Constructing Your Power Supply - Layout Considerations", by Robert Kollman  

"Current Carrying Capacity of Vias", by Doug Brooks and Dave Graves  

"Appendix B", Materials Science and Engineering - An Introduction, by William Callister  

Additions to V4.6 but not previously documented 
There are a few features which were introduced late into Pulsonix V4.6 and were not 
previously generally documented. 

Barcode Text 

You can add barcodes into you design using a special text font. 

 
From within the Technology file and Text Styles you can create a font style as normal. 
When you select the font however, choosing the built-in font of <Barcode Interleaved 2 
of 5> from the drop down list, it will present you with a list of parameters that can be 
assign to that font. These parameters describe the barcode features. 

 
Once the font has been defined, in the design, use the Insert Text option. In the text box 
presented, type in the barcode in numbers, for example 05505223. Choose a suitable layer 
for it to be added to. Once added to the design, use Change Style and select the newly 
created Barcode text style. The text will now be displayed as a barcode. 
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Properties Shows Calculated Area 

For a selected shape, if the shape is closed, even if just one segment of that shape is 
selected, the Properties dialog will now show the total Area in your current design units. 

 

New Component Mirroring Defaults 

You can default mirroring of SMD and through-hole components separately using the two 
check boxes in the Design Settings, Defaults and Component dialog. 

When Components are added to the design, this will force their ‘side’ automatically. 
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